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End User Software License 
 

 

READ CAREFULLY BEFORE USING THE SOFTWARE!  

 

By affirmatively accepting this license in the manner indicated in the directions, or by using the 

software beyond the use necessary to access and respond to the preliminary inquiries, you accept 

the terms of this license.  If you do not choose to accept the license, DO NOT PROCEED 

BEYOND THE END OF THE LICENSE TEXT and immediately return all copies of the software 

and accompanying documentation to InfoCAP Technologies at the address indicated on the 

product.  You acquire ONLY a non-exclusive license to use the software in machine readable form 

on a single user computer workstation in accordance with these terms and conditions.  You do not 

acquire title to the product, except for title to the physical medium which contains the software 

product.  You do not acquire any rights in the documentation other than the right of use to 

accompany the software.  The software and the accompanying documentation are copyrighted 

material.  You must not copy the software except for: 

(1) a single copy for the sole purpose of backup, 

and 

(2) such copying as is essential to load the software onto the single workstation. 

These copies MUST include the copyright notice and all other notices and product identification 

(serial numbers, trademarks, etc.) found in the original software.  You must not copy the 

documentation at all.  You are legally responsible for any copyright infringement which occurs as a 

result of any copying, by you or anyone else, of your copy of the software product or 

documentation.  The software contains trade secrets of InfoCAP Technologies or its licensers.  You 

are responsible for protecting the software from unauthorized disclosure or use.  Without limitation, 

this means at minimum that you must not modify, adapt, translate, extract, reverse engineer, 

decompile, disassemble, or in any way attempt to learn the source code of the software or any part 

of it.  You must not modify, adapt, translate or create derivative works (either of the software or the 

documentation) without InfoCAP Technologies's prior written consent.  You may not sell, 

sublicense, lease, lend or otherwise make the software, documentation or any part of them available 

to others, except that you may transfer the license to the product to a new licensee ONLY IF (1) the 

license is transferred to a person who consents to be governed by the terms of this license, (2) the 

product (including the backup copy and any other copies) and documentation is fully transferred to 

the new licensee without any copies or rights in the software product or documentation being 

retained by you, AND (3) you notify InfoCAP Technologies promptly of the name and address of 

the new licensee and include the serial number of the transferred Product.  No warranties extend to 

any new licensee.  You are responsible for complying with any export restrictions imposed by law. 

 

LIMITED WARRANTY:  If you send InfoCAP Technologies the registration card accompanying 

the software, completed and postmarked within ten days of your purchase, InfoCAP Technologies 

will warrant that, for one year from the date of purchase as shown on your receipt, the software as 

furnished will perform substantially in accordance with the accompanying documentation under 

normal and proper use, and that the physical medium as furnished will be free of defects in material 

and workmanship.  InfoCAP Technologies does not warrant that the software is suitable for the 

physical operating environment into which it is placed, nor does it warrant that it is suitable for an 

operator of any particular skill or experience.  This warranty does not extend to any software or 

hardware furnished with or accompanying the software.  The warranty is void in the event of abuse, 

improper use, negligence, accident, modification, alteration, tampering, failure to follow normal 

operating and maintenance procedures outlined in the documentation, attempted repair by other 

than InfoCAP Technologies, operation outside normal environmental and electrical specifications, 



 

  

or if the software's original identifications have been defaced, altered or removed.  InfoCAP 

Technologies's only obligation where this warranty applies is to either repair or replace the 

defective product, at its option. To make a claim under this warranty, you must during the warranty 

period send InfoCAP Technologies a written notice upon discovery of a defect, which must (1) 

include a detailed explanation of the defect and (2) be accompanied by proof of purchase showing 

the date purchased. 

 

DISCLAIMER OF WARRANTY: EXCEPT AS EXPRESSLY PROVIDED IN THE 

WARRANTY ABOVE, THE SOFTWARE IS PROVIDED "AS IS" WITHOUT EXPRESS OR 

IMPLIED WARRANTY, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES 

OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR 

PURPOSE. 

Neither InfoCAP Technologies nor anyone else involved in the creation, production or delivery of 

the product is liable for any damages relating to this agreement or its performance, including but 

not limited to indirect, consequential, incidental or punitive damages, regardless of the legal theory 

or cause of action under which you claim.   The exclusion applies, but is not limited to claims for 

lost profits or data.  The sole remedy for direct damages is stated in the warranty, above, even 

should the warranty fail as to its essential purpose.  In no case shall liability to you or any transferee 

exceed the fees paid by you for the product. 

This license automatically terminates if you or any transferee fail to comply with any provision of 

this agreement.  Provisions relating to warranties, limited liability, remedies or damages survive 

termination. 

This is the entire agreement relating to this product.  It may not be modified except in writing 

signed by both parties. 
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Chapter 1 Introduction 

What is PowerFilm? 
The PowerFilm application software is a high performance 

digital image processing solution for Eastman Kodak's 

2400DSV-E, 2400 DV Plus and 3000DSV-E, 3000 DV Plus 

universal microfilm scanners. 

PowerFilm provides a friendly Graphic User Interface (GUI) 

for converting fiche, jackets, aperture cards, 16mm 

cartridges, and 16mm and 35mm roll film, into electronic 

image files. 

Scanned images are grouped together in batches.  A batch 

will consist of all the images scanned in a particular scanning 

session. 

PowerFilm creates Tagged Image File Format (TIFF) files for 

each image and generates an index file for each set of TIFFs 

(the batch).  These images and index files are compatible 

with industry standard retrieval, optical character recognition 

(OCR), and image management systems. 

Users can optionally choose to convert scanned images to 

PDF format (PDF „Image Only‟ format) as a batch is saved. 

PowerFilm comes complete with CDPublish, and an option to 

install CDRetrieve.  CDPublish is a simple to use, out of the 
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box CD Publishing package that builds a database of indexed 

images. CDRetrieve is a CD Search and Retrieval system. 

Users are able to search and retrieve their indexed images, 

individual images or groups of images, by selected indexing 

criteria using CDRetrieve.  Refer to the 

CDPublish/CDRetrieve documentation for further details. 

PowerFilm drives the 2400DSV-E, 2400 DV Plus and 

3000DSV-E, 3000 DV Plus through a standard USB or SCSI 

interface without the need for any proprietary compression 

boards, though a compression board is required for greyscale 

scanning. 

Indexing 
Users are able to add index information to images as they are 

scanned or once scanning is completed. 

The index data captured may be exported as standard comma 

delimited data files (one for each batch) or in CDPublish 

(IDX) format.  If the CDPublish (IDX) format is chosen, the 

batches of images may be published into databases with 

CDPublish. These databases can later be searched by index 

field value using CDRetrieve. 

Image Control 
PowerFilm gives the user full control over image; 

composition, resolution and, contrast and brightness settings. 

Users are able to; enlarge/reduce the size of the viewed 

image, rotate the scanned image, navigate through images in 

a scanned batch and perform cut and paste functions on 

images in a batch. 
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Batch Control 
PowerFilm provides the facility for up to tri-level blip mark 

(image mark) counting on 16mm microfilm by supporting the 

MARS IV and Mini MARS II Controllers. 

From the PowerFilm user interface, users are able to navigate 

to, and scan, selected Blocks (Large blip), Batches (Medium 

blip) or Items (Small blips) on 16mm roll film.  The 

PowerFilm user interface has been updated to support the 

MARS IV Controller.  Some of the functionality is disabled 

when PowerFilm is used with a Mini MARS II Controller 

(for Dual Level film). 

See Chapter 5 Control and Operation for more information. 

Print, Mail and Fax 
Users are able to print individual images, or ranges of images 

in a given batch, via standard Windows drivers. 

PowerFilm also provides the facility to e-mail individual 

images, or ranges of images in a given batch, via the 

computer‟s default MAPI client mail handler. 

In addition, PowerFilm provides the facility to fax images 

using other third party fax software that integrates via the use 

of a fax print driver. 

Additional Options Available 
PowerFilm supports an additional cost option.  The feature 

will not appear in the user interface until the option is 

installed. 

Kofax Ascent Uploader 

This option allows PowerFilm to act as a Kofax Ascent 

Capture Scan Station.  When Kofax Ascent is selected as the 
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PowerFilm output format, the scanned images are 

automatically uploaded to Kofax Ascent Capture (versions 5 

to 7.5) when the batch is accepted. 

Kofax Ascent Capture enhances images, automatically or 

manually indexes images, validates index data, then releases 

images and data to one or more back-end systems via its 

broad library of custom release modules. Supported systems 

include Documentum 4i, FileNet Panagon, IBM Content 

Manager, OpenText Live Link, Optika Accorde, 

Hummingbird, KeyFile and dozens more.   

Note: A Kofax Ascent Capture scan station license is 

required for use with the PowerFilm Kofax Ascent Uploader 

Option. 

See Chapter 5 Control and Operation for more on Uploading 

to Kofax Ascent. 

The Operating System 
A Microsoft Windows-based application, PowerFilm operates 

on PC platforms running Windows 2000 Professional, 

Windows XP Professional, Windows Vista Business and 

Windows 7 Professional.  PowerFilm is powerful but 

relatively easy to use; however, operators should know the 

basic Windows controls before running the application. 

Process Overview 
PowerFilm software is designed to convert documents stored 

on fiche, jackets, aperture cards, 16mm cartridges, and 16mm 

and 35mm roll film into standard TIFF files, while avoiding 

repetitive setup and configuration procedures.  The idea is to 

maximise scanning productivity while minimising labour-

intensive work such as indexing, creating sub-directories for 

storage, and manually navigating from frame to frame.  
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About This Manual 
This manual provides the information you need to use 

PowerFilm.  This includes:  software usage, basic technical 

information such as file structures and storage, and hardware 

use. 

This manual does not attempt to explain Microfilming 

technology.  It is assumed that the user is familiar with 

Microfilm types, terms and concepts.  For specific Microfilm 

functionality supported by the 3000DSV-E, 3000 DV Plus 

and the 2400DSV-E, 3000 DV Plus, please refer to the 

product User Manuals. 

This manual does not explain Microsoft Windows.  If you 

have questions about Windows, please consult the Windows 

User Manual. 

Organisation of the PowerFilm 
Manual 

This manual consists of eight chapters which provide 

information necessary for the understanding and operation of 

PowerFilm. 

Chapter 1, Introduction, introduces PowerFilm and this 

manual. 

Chapter 2, Installing PowerFilm, provides the information 

needed to install and prepare PowerFilm for first use. 

Chapter 3, Getting Started, provides information on starting 

PowerFilm for the first time. 

Chapter 4, User Interface, provides detailed descriptions of 

the PowerFilm main window components and controls. 

Chapter 5, Control and Operation, details the parameters in 

each of the PowerFilm control tabs that increase the 

flexibility and control of the scanning process.  Opening and 

using recallable configurations is also covered. 
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Chapter 6, System Administration, describes system security 

and the set-up and maintenance of recallable configurations.  

This chapter also discusses special set-up options and system 

files that are be used to maintain PowerFilm efficiently. 

Chapter 7 Mail, Print, Fax Integration, details the setup and 

use of the PowerFilm Mail, Print and Fax facilities. 

Chapter 8 Localisation, describes the processes and files 

involved in translating all of the PowerFilm menus, dialogs 

and messages into alternative languages. 

Conventions Used in This Manual 
This manual uses certain conventions to facilitate your 

understanding of PowerFilm. The formatting conveys 

specific types of information. 

 

Monospaced type 1. Words or characters that you must 

type.  For example, if the manual 

reads “Type Cabinet 1,” then type 

the words exactly as you see them, 

including capitalisation. 

 

2. The contents of text files. 

 

Monospaced italic Information you must supply.  For 

example, “Type your password,” 

means you must enter your password in 

place of the words your password. 

 

[Square Brackets] Optional parameters.  Multiple options 

are separated by the pipe character (|).  

For example, “Type run [a | b]” means 

you can type run a or run b. 

 

Bold type 1.  Button names and menu options.  

For example, “Click on the Delete 

button or select the Del option from 

the File menu” 
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2.  System responses.  For example, 

“File not found.” 

 

SMALL CAPS Names of keys on your keyboard.  For 

example, "Press ENTER." 

 

Italic type File names and special information. 

 

Note Helpful information or special 

situations. 

Hint Useful information to help you use 

PowerFilm 

 

Caution Information that might prevent data 

corruption or minor system damage. 

 

Warning! Information that might prevent 

personal injury or major system 

damage. 

Online Help 
The Help menu contains two options:  Contents and About.  

The Contents option displays PowerFilm online 

documentation.  The About option displays copyright and 

version information along with useful information about your 

scanner, and SCSI Host Adapter or USB interface. 



 

PowerFilm User Manual 1-8 

Technical Support 
Users should contact their local Eastman Kodak Technical 

Support team regarding support issues with the PowerFilm 

application software. 

 

InfoCAP Technologies Ltd. 
Technology House 

Unit 3a, Coped Hall Business Park 

Wootton Bassett 

Wiltshire SN4 8DP (UK) 

 

Phone +44 (0) 845 1 305 170 

Fax +44 (0) 856 1 305 171 

E-mail Support@InfoCAP.co.uk 

 

Technical Support (UK) 

Phone +44 (0) 845 1 305 172 

Marketing/Sales Support (UK) 

Phone +44 (0) 845 1 305 170
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Chapter 2 Installing 
PowerFilm 

Installation Overview 
Before proceeding with the installation, please make sure the 

computer meets the minimum system requirements. 

PC Hardware Specification 
 

Quantity Product 
1 Pentium 4 with 512MB 

RAM 

1 Monitor capable of 

displaying at 800x600 

minimum resolution. 

1 USB2 Interface (if the 

scanner is to be attached 

via this interface). 

1 Adaptec 2940 or 2930 or 

2904 SCSI Controller.  

2930 or 2940 

recommended for Grey 
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scale scanning (if the 

scanner is to be attached 

via a SCSI interface). 

Windows Operating System 

PowerFilm is supported on the following Windows Operating 

systems: 

 Windows 2000 (Min SP4) 

 Windows XP Professional (Min SP2) 

 Windows Vista Business Edition. 

 Windows 7 Professional 

Screen Resolution 

PowerFilm has been designed to run in a minimum screen 

resolution of 800 x 600 pixels (small fonts).  In this screen 

resolution PowerFilm‟s Control Tab parameters will 

optimally fit the screen. 

Note: At a resolution of 800x600, it may be necessary to 

set the Windows Taskbar Options to Auto Hide to 

view the PowerFilm Status Bar. 

 

Note: It is recommended that The Windows Colour Palette 

is set to the highest possible quality for the sharpest 

display of images. 

Scanner Hardware Interface 

PowerFilm supports the SCSI or the USB interface on the 

2400DSV-E, 2400 DV Plus and 3000DSV-E, 3000 DV Plus 

scanners.  PowerFilm communicates with the scanner on the 
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USB bus by default.  To configure PowerFilm to use the 

SCSI interface, refer to Chapter 6 – System Administration. 

Using the USB Interface 

Ensure that the scanner is set to identify itself as a Konica 

Minolta device.  If you are unsure how to do this, contact 

your Kodak technical representative. 

Note: Do not attach the scanner to the PC via the USB 

interface until after PowerFilm has successfully been 

installed (see Installing PowerFilm below). 

Using the SCSI Interface 

Before installing the SCSI host adapter, read the installation 

guide provided by Adaptec.  The adapter‟s default settings 

will usually work fine.  Conflicts with the host adapter‟s 

BIOS address, IRQ or I/O port address settings, or improper 

SCSI termination can significantly add to the time needed to 

configure the PC. 

To Install the Hardware: 

1. Ensure that the computer‟s AC power cord is 

disconnected. 

2. Install the Adaptec SCSI host adapter into the 

computer, following the installation directions 

supplied with the host adapter. 

3. Connect the SCSI cable to the host adapter and the 

scanner. 

4. Power on the scanner and then the PC, taking note 

of the SCSI ID displayed on screen during system 

boot up. 

5. PowerFilm will automatically scan the SCSI bus to 

find the scanner. 
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When powering on the computer the Adaptec BIOS 

initialisation message should display before starting 

Windows.  The Adaptec adapter lists all of the SCSI devices 

it recognises. 

Note: The Adapter‟s default settings can be changed by 

pressing CTRL+A during system boot up 

SCSI Drivers  

Always use the latest Windows ASPI and SCSI drivers 

specific to the SCSI board you are using. 

The ASPI driver is a software program that enables the host 

adapter to communicate with the devices on the SCSI bus. 

Installing PowerFilm 

If you are using the scanner‟s USB interface, do not attach 

the scanner to the PC until PowerFilm has successfully been 

installed.  The PowerFilm installation program will detect the 

presence of the appropriate USB drivers and automatically 

install them if they are not already installed. 

If you are using the scanner‟s SCSI interface, the Adaptec 

SCSI Host Adapter should be installed and configured before 

installing PowerFilm.  Check all cable connections on the PC 

and scanner.  In most cases, the scanner should be powered 

up before the computer. 

To Install PowerFilm:  

1. Insert the PowerFilm installation CD into the CD drive. 

2. The CD should Autorun.  If not, run „Setup.exe‟ from the 

root of the CD. 

3. The PowerFilm installation start up screen prompts you 

for the language you would like to run PowerFilm in.  
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4. Click on the flag representing the language you would like to install 

in. 

Note: This will affect the language the installation screens are 

displayed in as well as the PowerFilm interface language. 

5. Follow the prompts to install the PowerFilm software.  If the 

installation detects that the scanner USB drivers are not installed, you 

will be prompted to install them. 

6. When the installation completes, you will be prompted to reboot the 

PC.  You may find that this is unnecessary depending on the Windows 

operating system you are using. 

7. If you are using the scanners USB interface, attach the scanner to a 

USB2 port on the PC and switch on the scanner.  Windows should 

recognise that the scanner is connected. 

8. You are now ready to start PowerFilm. See the PowerFilm software 

licensing procedure below. 

 
 

Fig 1. PowerFilm Installation Start up Screen 
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PowerFilm Software Licensing 
Procedure 

The PowerFilm software licensing system has been 

engineered to make installation and registration of the 

software easy.  A Licence Manager program is provided to 

allow users to configure their licenses.  When the software is 

installed, a 14-day license is automatically enabled.  The 

following section describes the steps involved in obtaining a 

permanent licence for the software.  Please refer to the 

software registration form that you should have received with 

the software. 

Licensing the Software 

Once the 14-day license has expired, a Software Licence 

KEY is required to activate an unlimited licence.  This key 

ties the installation of PowerFilm to the PC you are installing 

the software onto.  The Software Licence KEY can be 

requested at any time during (or after) the 14-day period. 

Software Site CODE 

The Software Site CODE is an encoded number that 

uniquely identifies your PC.  Your Software Licence KEY is 

generated from the Software Site CODE and so is only valid 

for the PC on which the Software Site CODE was generated. 

To generate your Software Site CODE, you need to run the 

Licence Manager.  From the Windows Start menu, navigate 

to the KODAK-PowerFilm Program Group and select 

Licence Manager‟. The Licence Manager user interface is 

displayed. 
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The Licence Manager interface is divided into two sections; 

Generate Site Code and Configured Licence Keys. 

Generating Site Codes 

The Generate Site Code section allows you to enter the serial 

number (ref. Number) for the software (which can be found 

on the product packaging and on the software registration 

form) and generate your unique Software Site Code. 

Enter your Software Serial Number (ref. Number) and press 

the Generate Site Code button. 

 

 

 

 
 

Fig 2. Licence Manager 

 

Fig 3. Generate Site Code 
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You should now save a Site Code File (SiteCode.dat) by 

pressing the Save Site Code File button. 

 

 

 

 

 

 

 

 

 

 

 

By default the SiteCode.dat file will be saved in the software 

installation folder but you can save it to any available folder 

on your PC. 

Software Licence KEY 

You obtain your Software Licence KEY by sending the 

following details along with the SiteCode.dat file to the 

contact details provided on the software registration form. 

 Your name and contact details 

 Your company name and address 

 Date the software was received 

 Reference number for the software (on the product 

packaging) 

Once your request for a Software Licence Key has been 

processed, you will be sent a Licence File that you can use to 

configure your licence in the Licence Manager. 

 
 

Fig 4. Save Site Code File 
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Configuring Licence Keys 

When you receive your Licence File (LicenceKey.dat), save 

it to the same location you used when saving the SiteCode.dat 

file and then run the Licence Manager again.  This time using 

the Load Licence File button in the lower part of the Licence 

Manager interface, add the licence to the system. 

 

 

 

 

 

 

 

 

 

 

Once you have opened the Licence File, you should receive 

confirmation that the licenses were successfully loaded. 

 

Once you have loaded the Licence File, your configured 

licences will be displayed in the user interface. 

 

 

 

 

 
 

Fig 5. Open Licence Key File 
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You may now close the Licence Manager program and start 

using the software.  

 

 

Fig 6. Loading Licenses 
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Chapter 3 Getting Started 

Starting PowerFilm 

1. Start Windows and, if necessary, logon to the network. 

2. Double-click the PowerFilm icon on the desktop (or 

from the Start Menu select Programs-Kodak-

PowerFilm and navigate to the PowerFilm program) to 

start the program. 

Note: If you are starting PowerFilm for the first time a 

dialog box will appear now asking you for the 

Software Serial number and the default Supervisor 

Password. 
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Enter your software serial number and the 

default password and press OK. 

The PowerFilm User Interface displays. 

Note: Help - About will display confirmation that the 

scanner has been detected by PowerFilm. 

Configurations 
Settings such as Film Control Parameters, Image Attributes, 

output directory and index parameters are stored by 

PowerFilm in “templates” or configuration files.  These 

configurations can be retrieved later, eliminating the need to 

reset the parameters for subsequent scanning sessions.  See 

Chapter 5 Control and Operation for information on using 

configurations; see Chapter 6 System Administration for 

information on creating and maintaining configurations. 

 
 

Fig 1. The Serial Number Dialog 
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When PowerFilm is started for the first time, a Default 

Configuration is loaded.  Although the default configuration 

may be used for test scans, a new configuration should be 

created before continuing.  Creating a new configuration 

requires the Supervisor Password. See Chapter 6 System 

Administration for further details. 

You are now ready to begin scanning.  Review Chapter 5 

Control and Operation for information on setup parameters 

and control of the scanning process. 

Exiting PowerFilm 
 

1. To exit PowerFilm, select Exit from the File menu. 

2. The Exit PowerFilm dialog displays. 

3. Click on OK to exit. 

If changes were made to the active configuration you are prompted for 

the Supervisors Password to save the configuration.  See Chapter 6 

System Administration for information on the Supervisors Password) 

 

4. Click on OK to save the changes.  Click on Cancel to exit PowerFilm 

without saving the changed configuration. 
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Chapter 4 User Interface 

The Main Window 
PowerFilm has been designed so that most of the common 

scanner controls and image manipulation functionality is 

accessible from the user interface main window. 

 
 

Fig 1. The PowerFilm User Interface Main Window 
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The following sections describe each portion of the main 

window. 

Title Bar 

The title bar contains the standard MS Windows control 

items including the Windows control menu and 

maximise/minimise buttons.  The centre of the bar displays 

the software‟s title and the name of the active configuration.  

Status Bar 

The left hand side of the status bar displays activity 

information, e.g., during the scanning process the Status Bar 

will display Scanning. 

The right hand side of the status bar displays the path and the 

name of the current image being scanned. 

And, from version 5.3, the right side of the status bar handily 

displays the size (in KB) of the scanned image. 

Menu Bar 

The menu bar contains six menus: File, Configuration, 

Action, View, Annotation and Help.  The following sections 

list the options available from each menu.  Where 

appropriate, accelerator keys are shown in brackets for each 

menu function. 

Many of the menu functions are also available from the main 

window button bar, discussed later in this chapter. 

To Select an Option from the Menu Bar: 

1.   Using the mouse, click on the menu title (for 

example, File. 

The drop-down menu displays the available menu items. 

2.   Click on the desired menu item. 
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File Menu 

The following items are available in the File Menu. 

 

Print (F2) Allows you to print individual 

images or a range of images.  See 

Chapter 7 E-Mail, Print and Fax 

Integration for more details. 

 

Fax (F3) Allows you to fax individual 

images or a range of images to 

third party fax software that may 

be installed on your PC.  See 

Chapter 7 E-Mail, Print and Fax 

Integration for more details. 

 

Email (F4) Allows you to Email individual 

images or a range of images.  See 

Chapter 7 E-Mail, Print and Fax 

Integration for more details. 

 

Load Batch Allows you to open a batch of 

images that were scanned in a 

previous scanning session, to 

allow you to add indexing data, 

manipulate images and integrate 

with Print, Fax and Email 

services. 

 See Chapter 5 Control and 

Operation for more details. 

 

Load Suspended Batch Allows you to re-open a batch of 

images that has not yet been 

completed. Refer to Chapter 5 

Control and Operation for more 

details. 
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Save Image As Define what name to assign and 

where to save the currently 

selected image. Images may be 

saved with the TIFF file extension 

or as PDF files. 

 

Save Image As 

Multipage 

Define what name to assign and 

where to save the currently open 

batch of images in a multi-page 

image file. Multi-page Images 

may be saved with the TIFF file 

extension or as a PDF file. 

  

Options Provides access to special set-up 

screens that allow you to 

configure the PowerFilm 

environment.  See Chapter 6 

System Administration for more 

details. 

 

CD Publish Launches CD Publish. Enabling 

you to build a database of your 

data; publish your TIFF files. The 

database will also contain any 

index field values associated with 

the data for quick and easy 

retrieval using CD Retrieve. 

 

Exit Closes PowerFilm. 

 

Note: you cannot close PowerFilm 

down during a batch.  You must 

either Accept, Reject or Suspend 

the batch. 

Configuration Menu 

The following items are available in the Configuration Menu. 
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New Configuration Creates a new recallable 

configuration to store PowerFilm 

setup parameters.  The Supervisor 

Password is required.  See Chapter 

6 System Administration for more 

details.  

 

Open Configuration Shows a list of existing 

configurations that may be opened. 

See Chapter 5 Control and 

Operation for more details.  

 

Save Saves any changes you may have 

made to the current configuration. 

The Supervisor Password is 

required.  See Chapter 6 System 

Administration for more details.  

 

Save As Saves the current configuration as a 

new configuration and prompts you 

for a new name. The Supervisor 

Password is required.  See Chapter 

6 System Administration for more 

details.  

 

Rename Renames the current configuration. 

The Supervisor Password is 

required.  See Chapter 6 System 

Administration for more details.  

 

Delete Deletes the current configuration. 

The Supervisor Password is 

required.  See Chapter 6 System 

Administration for more details.  
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Setup Indexing Opens the Indexing Setup screen to 

allow you to define index fields for 

the current configuration. The 

Supervisor Password is required.  

See Chapter 6 System 

Administration for more details.  

Action Menu 

The following items are available in the Action Menu. 

 

Scan (F5) Starts the Scanning Process.  See 

Chapter 5 Control and Operation 

for more details. 

 

Save Batch (F6) Closes and Saves the scanned 

batch. See Chapter 5 Control and 

Operation for more details. 

 

Move Next (F7) Only available if a Mini MARS II 

or MARS IV controller is installed 

and detected.  Instructs the 

controller to advance one frame. 

See Chapter 5 Control and 

Operation for more details. 

 

Go to Start (F8) Only available if a Mini MARS II 

or MARS IV controller is installed 

and detected.  Instructs the 

controller to go to the first frame on 

the film. See Chapter 5 Control and 

Operation for more details. 
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Rewind Cartridge 

(Ctrl+F) 

Only available if a Mini MARS II 

or MARS IV controller is installed 

and detected.  Instructs the 

controller to rewind and eject the 

film cartridge.  See Chapter 5 

Control and Operation for more 

details. 

 

Merge with Previous 

Page 

Merges the currently highlighted 

image with the image to the left of 

it in the batch. 

 

See Chapter 5 Control and 

Operation for more details. 

 

Append Pages Adds pages to the end of the 

current batch when the scan 

command is executed. 

 

Insert Pages Inserts pages to the right of the 

current highlighted image in the 

batch when the scan command is 

executed. 

 

See Chapter 5 Control and 

Operation for more details. 

View Menu 

The following items are available in the View Menu. 

 

Options Allows you to select how often 

images are displayed in the image 

viewer window.  See Chapter 5 

Operation and Control for further 

details. 

 

Next (F12) Displays the next image in the 

batch. 
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Previous (F11) Displays the previous image in the 

batch. 

 

First (F9) Displays the first image in the 

batch. 

 

Last (Ctrl+E) Displays the last image in the 

batch. 

 

Rotate Left (Ctrl+L) Rotates the current image 90° to the 

left. 

 

Rotate Right (Ctrl+R) Rotates the current image 90° to the 

right. 

 

Delete Deletes the current image from the 

batch. 

 

Save (Ctrl+S) Saves any rotations or changes to 

the current image. 

 

Scale to Gray Sets the image viewer display 

mode to Scale to Gray.  Greyscale 

display makes black and white 

documents easier to read, and is 

most effective at a zoom 

percentage of less than 100%. 

 

Fit to Page (Ctrl+P) Fits the current image to the size of 

the viewing window and saves this 

view for subsequent images. 

 

Fit to Width (Ctrl+W) Fits the current image to the width 

of the viewing window and saves 

this view for subsequent images. 

 

Fit to Height (Ctrl+H) Fits the current image to the height 

of the viewing window and saves 

this view for subsequent images. 
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Cut (Ctrl+X) Cuts a selected area of the image to 

the Windows clipboard.  This 

function is also used to Redact 

(Mask White) unwanted or 

sensitive areas of the image before 

the image is printed, faxed or e-

mailed. 

 

Copy (Ctrl+C) Copies a selected area of the image 

to the Windows clipboard. 

 

Keep Selected (Ctrl+K) Reduces the current image to the 

size of the selected area.  This is 

not a viewing function; the actual 

image size is reduced. 

 

Paste (Ctrl+V) If the Cut or Copy functions have 

previously been used, this function 

pastes the contents of the Windows 

clipboard into the image viewing 

window 

 

Show n Viewers Choose to display 1, 2, 4 or 6 

images at a time during scanning. 

Annotation Menu 

There are four items available in the Annotation menu. 

 

Show Annotation 

Toolbar 

 

Displays the annotation toolbar. 
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Show/Hide Annotations Choose to display or hide 

annotations, prior to making them 

permanent. 

 

Note: This function displays or 

hides the annotations on the 

currently selected image.  Users 

will be prompted to save the image 

with the annotations displayed or 

hidden. 

  

Delete Selected 

Annotations 

Choose to remove the selected 

annotations. 

 

Burn In Annotations Makes annotations permanent.  

This function effectively writes to 

the TIFF File, creating a new TIFF. 

Help Menu 

There are two items available in the Help menu. 

 

Contents (F1) Displays the PowerFilm electronic 

User Manual help contents. 

 

About Displays PowerFilm copyright and 

version information along with 

useful information about the 

scanner that PowerFilm has 

detected. 

Main Window Button Bar 

For easy access, many of the menu functions are also 

available from the main window button bar.  As the mouse is 

hovered over each button, windows hover help is displayed 

indicating the buttons function. 
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Start Scanning/Resume 

Scanning.  This is a multi function 

button.  It starts the scanning 

process if no batch is in progress.  

If a batch is in progress pressing 

this button resumes scanning. 

 

 
Close Batch/Cancel Scanning.  

This is a multi function button.  If a 

Mini MARS II / MARS IV scan 

(multiple frames/batches) is 

underway, this button will cancel 

scanning.  If no scanning is taking 

place this button closes the batch. 

 

 
Print.  Print the current image or 

range of images. 

 

 
Fax.  Fax the current image or 

range of images 

 

 
Mail.  Email the current image or 

range of images. 

 

 
Save Configuration.  Saves any 

changes made to the current 

configuration. 

 

 
Rewind.  Rewinds the film 

cartridge.  Only displays if the Mini 

MARS II controller is connected 

and detected. 

 

 
Move to Next Frame. Only 

displays if the Mini MARS II or 

MARS IV controller is connected 

and detected. 
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Rescan Image.  Allows you to 

rescan an image over the top of a 

previously scanned image. 

 

 
Select.  Sets the image viewer 

window to Zoom mode.  In this 

mode you can “rubber band” an 

area of the image viewer window 

you wish to enlarge (or 

print/fax/email). 

 

 
Drag.  Sets the image viewer 

window to Drag mode.  Only 

functional if the current image does 

not fit in the image viewer window.  

In this mode you can drag the 

image in any direction to view 

different areas of the image. 

 

 
Allows you to set a custom view 

size. 

 

 
Zoom in.  Zooms in on the image 

in the image viewer window. 

 

 
Zoom out.  Zooms out on the 

image in the image viewer window. 

 

 
Zoom to Select.  Zooms to the area 

of the image selected by rubber 

banding with the mouse while in 

Select mode. 

 

 
Rotate Left.  Rotates the image 

90° to the left. 

 

 
Rotate Right.  Rotates the image 

90° to the Right. 
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Page Navigation.  Left arrow 

moves to previous page.  Right 

Arrow moves to next page.  

Entering a value in the box and 

pressing enter moves to a specific 

image in the batch. 

 

 
Cut / Mask White.  Cuts a selected 

area of the image to the Windows 

clipboard.  This function is also 

used to Redact (Mask White) 

unwanted or sensitive areas of the 

image before the image is printed, 

faxed or e-mailed. 

 

 
Copy.  Copies a selected area of 

the image to the Windows 

clipboard. 

 

 
Paste.  If the Cut or Copy functions 

have previously been used, this 

function pastes the contents of the 

Windows clipboard into the image 

viewing window 

 

 
Delete Image.  Deletes the current 

image from the batch. 

 

 

 
Save Image.  Saves any rotations 

or changes to the current image. 

 

Control Tabs 

For ease of use, PowerFilm has been designed to allow the 

user to access each section of the scanner control, setup and 

configuration independently on Control Tabs.  Any one of the 

Control Tabs may be viewed during the scanning process. 
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If a Mini MARS II or MARS IV controller is fitted there will 

be five Control Tabs available; Film, Index, Batch, Image 

and Options. 

Control Tabs are discussed in more detail in Chapter 5 

Control and Operation. 

Film 

This Control Tab will only display if PowerFilm has detected 

a Mini MARS II or MARS IV controller connected to the 

scanner. 

The Film Control Tab gives the user access to Film setup 

parameters and Blip search and navigation control. 

Index 

Allows the user to enter configuration-specific indexing 

information for ranges of images as they are scanned, or later. 

Batch 

Allows the user to control where the images will be scanned 

to and how the images should be arranged in folders and sub 

folders.  Users are also able to define the type of output data 

file that should be exported. 

Image 

Provides control over Image Sizes, Image attributes and 

Brightness and Contrast settings. 

Options 

Provides access to scanner specific functions such as; Auto 

Masking and Centering. 

 
 

Fig 2. PowerFilm Control Tabs 
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Chapter 5 Control and 
Operation 

Overview 
This chapter discusses the use of the parameter settings in the 

individual PowerFilm Control Tabs, image file storage, file 

output and viewing parameters that increase the flexibility 

and control of the scanning process. 

PowerFilm enables users to store all scanner parameters setup 

on any of the Control Tabs, such as image sizes, resolution, 

contrast and film types in “templates” or configuration files.  

These configuration files can be retrieved later, eliminating 

the need to reset the parameters for subsequent scanning 

sessions.  The opening and recalling of these user definable 

configurations is also covered in this chapter. 

Control Tabs 
Each Control Tab contains parameter and configuration 

settings that relate to particular areas of scanner control.  For 

example, the Film Control Tab contains the setup parameters 

that relate to Microfilm - and in particular the Mini MARS II 
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controller, the Image Control Tab contains the setup up 

parameters that relate to size and composition of the images 

to be scanned, etc. 

To select the required Control Tab, click on the Tab Name 

with the mouse.  Once a tab is selected you can switch 

between tabs by pressing Ctrl+Tab. 
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Film Control Tab 

The Film Control Tab is used to control the MARS IV and 

Mini Mars II controller functionality for Single, Dual or Tri 

level blipped microfilm.  Depending on the controller being 

used, certain functionality will be enabled / disabled. 

 
 

Fig 1. The Film Control Tab 
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The Film Control Tab is divided into the following sections. 

MARS Control 

The MARS Control options allow the user to set the film blip 

parameters, control the initial positioning of the first frame of 

the film and rewind the film cartridge. 

 

Setup Film Applies the parameters set in the 

Blip Configuration section. 

 

Note: This can only be done when 

the film is rewound and ejected. 

 

Note: Until the Film Type is set 

none of the controls on the other 

sections on the Film Control Tab 

will be enabled. 

 

Once the Film Type is set the 

Setup Film button will be 

disabled.  You should check that 

the parameters applied are 

reflected on the front panel of the 

MARS Controller before 

continuing. 
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Goto Start Instructs the MARS Controller to 

go to the first frame on the film. 

 

Hint: Goto Start, instructs the 

MARS controller to position the 

film at Block 1, Batch 0, Frame 0 

for Tri level film and Batch 1, 

Frame 0 for Dual Level Film.  If 

the address of the first frame of 

each batch starts at 1 rather than 0, 

then you should set the MARS 

options accordingly on the 

Controller tab of the PowerFilm 

Options screen (File | Options). 

 

Rewind Rewinds and ejects the film 

cartridge. 

 

Hint: Rewind is also available 

from the button bar. 

 

Additional MARS Controller Support 

In addition to using the Mini MARS II controller, PowerFilm 

now provides support for the MARS IV Roll Film Carrier 

Controller.  Users are now able to navigate to, and scan, 

selected Blocks (Large blip), Batches (Medium blip) or Items 

(Small blips) on 16mm roll film.  The PowerFilm user 

interface has been updated to support the MARS IV 

Controller.  Some of the functionality is disabled when 

PowerFilm is used with a Mini MARS II Controller (for Dual 

level film). 

Please refer to the release notes to confirm the Roll Film 

Carriers that are supported and appropriate firmware 

revisions for the MARS IV controller and the carrier being 

used. 
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Setup and Configuration 

The MARS Controller should be installed and tested using 

the unit‟s manual keypad before use with PowerFilm.  Ensure 

that the configuration of the communications interface 

matches the parameters setup in PowerFilm. 

PowerFilm Setup 

From the Main PowerFilm interface select Options from the 

File menu.  Select the Controller Tab.  

In the Controller section select MARS II or MARS IV as 

appropriate. 

 
 

Fig 2. Controller Options Dialog 
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Note: Ensure that all other sections on the Controller Tab are 

completed correctly. (COM Port, Baud Rate, Parity, etc.) 

Press OK and restart PowerFilm. 

When PowerFilm is restarted, the Film Control Tab will be 

displayed. 

Hint: If the Film Tab does not appear PowerFilm may be 

having difficulty communicating with the MARS Controller.  

Check that the serial cable is fitted securely and that the 

COM Port setup is correct. 

Blip Configuration 

The Blip Configuration options setup the polarity of the blips 

on the film and blip level of the film to be scanned. 

 

Polarity Defines whether the blip polarity 

is Opaque (Negative) or 

Transparent (Positive). 

 

Level Defines the blip level for the film 

to be scanned. 

 

A Channel Single Level - Single 

level blips in channel A. 

B Channel Single Level - Single 

level blips in channel B. 

A Channel Dual Level - Dual 

level blips in channel A. 

B Channel Dual Level – Dual 

level blips in channel B. 

A Channel Tri Level - Tri level 

blips in channel A. 

B Channel Tri Level - Tri level 

blips in channel B. 
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 Note: The Tri Level options only 

appear when a MARS IV 

Controller has been configured. 

 

Two additional modes are 

available with the MARS IV 

Controller (even though they only 

relate to dual level blips). 

 

B Channel Batch – A Channel 

Item – Batch (medium) level blips 

in Channel B and Item (small) 

level blips in Channel A. 

 

A Channel Batch – B Channel 

Item – Batch (medium) level blips 

in Channel A and Item (small) 

level blips in Channel B. 

 

Note: If the blip level is set 

incorrectly for the film type 

loaded, the Mini MARS II 

Controller will not be able to 

search the film correctly and the 

film may rewind and eject when 

Goto Start is pressed. 

 

Search 

The Search options provide a mechanism to navigate to the 

starting point from which you wish to begin scanning. 

 

Block Only enabled if the Blip 

Configuration Level is set to one 

of the Tri options. 

 

Enter the number of the Block you 

wish to search for. 
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Batch Only enabled if the Blip 

Configuration Level is set to one 

of the Dual or Tri options. 

 

Enter the number of the Batch you 

wish to search for. 

 

Frame Enter the number of the frame you 

wish to search for. 

 

Note: The MARS Controller may 

be configured to start counting 

item level blips from 0 or 1. 

 

Search Button Begins the search for the specified 

Block, Batch and Frame. 

 

Note: If you search for an address 

on the film that does not exist, the 

MARS controller may randomly 

rewind (re-file) the film.  If this 

occurs, reload the film and search 

for an alternative address. 

Move 

The Move options provide a mechanism to move forward any 

number of frames from the Current Position. 

 

Distance Enter the number of frames you 

want to move forward by. 
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Move Button Begins the move forward 

operation. 

 

Note: With the MARS IV you 

may only move forward in 

increments greater than 1 within 

the same batch (medium level) on 

the film.  Move forward one frame 

at a time will cross Batch 

boundaries. 

 

Hint: Move forward one frame at 

a time is available from the button 

bar. 

 

Microfilm Control 

The Microfilm Control section allows the user to specify the 

range of images and batches that should be scanned. 

 

Scan All Frames Instructs the MARS Controller to 

scan all frames from the current 

position when the Scan button on 

the button bar is pressed. 

 
 

Scanning will cross Block and 

Batch boundaries until the end of 

the film has been reached. 
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Scan Next n Blocks Instructs the MARS Controller to 

scan the specified number of 

blocks from the current position 

when the Scan button on the 

button bar is pressed. 

 
 

Only available if the Blip 

Configuration Level is set to one 

of the Tri level options. 

 

Note: On Tri level film, if you 

specify that PowerFilm should 

scan more batches than exist in the 

current block, only the batches in 

the current block will be scanned. 

 

Scan Next n Batches Instructs the MARS Controller to 

scan the specified number of 

batches from the current position 

when the Scan button on the 

button bar is pressed. 

 
 

Only available if the Blip 

Configuration Level is set to one 

of the Tri or Dual level options. 

 

Scan Next n Frames Instructs the MARS Controller to 

scan the specified number of 

frames from the current position 

when the Scan button on the 

button bar is pressed. 

 
 

Note: Scanning any number of 

frames will cross Batch and Block 

boundaries on the film. 
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Current Position 

The Current Position section is an information only display 

which indicates the current Block, Batch and Frame position 

on the film. 

 

Block Current Block number (only 

enabled for Tri level film) 

 

Batch Current Batch number (only 

enabled for Tri or Dual level 

film). 

 

Frame Current Frame number. 

  

Note:  The Current Position on the film indicator will only 

be correct if PowerFilm was used to locate the batch and 

frame.  If the MARS Controller was used manually to move 

to a different frame the Current Position indicator will not be 

updated until scanning starts or a new search or move is 

instigated from PowerFilm. 
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Index Tab 

The Index Control Tab allows the user to enter indexing data 

that may be linked to each image or range of images in a 

batch.  The indexing data may then be exported in *.IDX 

format, for further publishing and retrieval using CDPublish 

and CDRetrieve, or in comma delimited *.CSV format. 

 
 

Fig 3. The Index Control Tab 
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The Index Control Tab consists of the following sections. 

Index Field Labels 

Index field labels are specific to the current configuration.  

For example, if you opened a configuration called “ABC 

company” the index fields displayed may be different to 

those in a configuration called “XYZ company”. 

The index fields are setup for each configuration via the 

Setup Indexing option on the Configuration menu.  The 

Supervisor password is required to setup indexing in any 

configuration.  See Chapter 6 System Administration for 

details on how to setup index field configurations. 

Index Fields 

The index fields are where you enter the data that you would 

like to relate to the image or range of images that will be 

scanned. 

Some index fields may have been defined as mandatory or 

require specific data formats.  If you do not enter a mandatory 

field or the data is not of the correct format PowerFilm will 

display a warning message. 

New Index Button 

The New Index Button clears the current values in the index 

fields and restores any default values that may have been 

defined in indexing setup. 

Note: See Using Indexing later in this chapter for further 

detail on applying Indexing data to images and 

ranges of images. 

  See Chapter 6 System Administration for details on 

using Indexing Setup. 
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Batch Tab 

The Batch Control Tab allows the user to control where the 

images will be scanned to and how the images should be 

arranged in folders and sub folders.  Users are also able to 

define the type of output data file that should be exported. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Fig.4 The Batch Control Tab 
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The Batch Control Tab consists of the following sections. 

Base Directory 

This is the Base Directory for the current configuration to 

build batches under.  Each batch is stored in a sub directory 

(or sub folder) under the Base Directory. 

Clicking on the Browse… button brings up the following 

dialog box: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Users are able to define UNC paths as the output path for 

scanned batches.  Additionally, users may create new folders 

from this dialog.  To create a new folder click on the Make 

New Folder button: 

Image File Naming 

The Image File Naming options allow the user to define how 

batch sub directories should be created, the number of images 

in each batch sub directory, file naming prefixes and image 

 
 

Fig.5 The Browse for Folder Dialog Box 
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numbering.  Users are also able to define the index data 

export type for the current configuration. 

 

Batch Subdirs by Automatically groups images into 

sub directories under the output 

directory.  Select one of the 

following options to determine 

when new sub directories are 

created. 

 

Note: This parameter is only read 

when beginning scanning a new 

batch.  Changing the parameter 

mid batch will have no effect. 

 

Count Limits the number of image files 

per sub directory according to the 

number entered for Files per 

Subdir.  When the number of 

images in a sub directory reaches 

the specified limit, a new sub 

directory (and new *.IDX file or 

*.CSV file) are created for the next 

group of images. 

 

Note: This parameter is only read 

when beginning scanning a new 

batch.  Changing the parameter 

mid batch will have no effect. 

 

Start/Stop Creates a new sub directory (and 

new *.IDX or comma delimited 

data file - *.CSV file) each time a 

batch is closed and a new 

scanning session started. 
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Files per Subdir Becomes available when Batch 

Subdirs By is set to Count. This is 

a user-definable number of files 

per subdirectory. 

 

Note: This parameter is only read 

when beginning scanning a new 

batch.  Changing the parameter 

mid batch will have no effect. 

 

Name Prefix Defines the sub directory and 

image file prefix (up to four 

characters) for all sub directories 

and images created using this 

configuration.  For example, a 

prefix of “INFO” will create an 

initial batch sub directory of 

INFO0001 and an initial image of 

INFO0001.TIF under the Base 

Directory. 

 

Note: This parameter is only read 

when beginning scanning a new 

batch.  Changing the parameter 

mid batch will have no effect. 

 

Tiff Start Count Defines the starting number of the  

First image to be scanned into the 

next batch. 

 

Note: This parameter is only read 

when beginning scanning a new 

batch.  Changing the parameter 

mid batch will have no effect. 
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Restart Count Restarts the image numbering 

each time a batch is closed and a 

new scans begins. 

 

Note: This parameter is only read 

when beginning scanning a new 

batch.  Changing the parameter 

mid batch will have no effect. 

 

Continuous Count The image numbering will 

continue to increment for all 

images scanned with this 

configuration until the Tiff Start 

Count is reset to 1. 

 

Note: This parameter is only read 

when beginning scanning a new 

batch.  Changing the parameter 

mid batch will have no effect. 

 

Output Options 

The Output Options allows the use to define the output 

format that the index file should be exported in. 

 

CDPublish Format (IDX 

File) 

IDX files are created which are 

compatible with CDPublish and 

CDRetrieve software products, as 

well as post-scan image 

enhancement applications, such as 

StageWorks, or Kofax Ascent, or 

any other product that meets the 

format requirements. 

 

Hint:  You may instantly create 

your database by launching 

CDPublish from the File Menu.   
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Comma Delimited Creates a standard comma 

delimited *.CSV file.  The index 

fields are exported in the 

following order: image file name 

(no path), date (in Windows long 

date format), index field 1, index 

field 2, index field 3, etc.  Each 

field is enclosed in double quotes 

(“”) to allow for comma 

characters in the field. 

 

PDF Only / Single 

Document 

A single PDF file is created for all 

the images scanned in the batch. 

 

PDF Only / MPage Doc 

Per Batch 

As above but the number of 

images in the PDF file is 

controlled by the Max Pages 

setting.  Setting Max Pages to 1, 

results in a PDF file being created 

for every image scanned. 

 

PDF Only / MPage Doc 

Boundary 

When scanning blipped microfilm, 

a new PDF file is automatically 

created for every Chapter (level II 

image address) on the film. 

 

PDF and Tif Options as per above (Single 

Document/MPage Doc Per 

Batch/MPage Doc Boundary), but 

the PDF file will be accompanied 

by a TIFF file. 
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Kofax Ascent With this option selected, scanned 

images are automatically uploaded 

into Kofax Ascent Capture 

(versions 5 to 7.5 inclusive) when 

the batch is accepted.   

 

This will only be available if the 

Kofax Ascent Uploader has been 

purchased. 

 

See Uploading to Kofax Ascent, 

below, for more information. 
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Tiff Type 

 

Single Document – outputs only 

single page TIFF files. 

 

Note: When this option is enabled 

and PDF output is chosen, a single 

PDF file is created for all the 

images scanned in the batch. 

 

MPage Doc per batch – outputs 

one multipage TIFF file for all the 

images scanned up until the batch 

is closed or as each sub dir is 

created if Batch Subdirs by: is 

set to Count. 

 

Note: When this option is enabled 

and PDF output is chosen, the 

PDF file is controlled by the Max 

Pages setting (see below).  For 

example, setting Max Pages to 1, 

results in a PDF file being created 

for every image scanned. 

 

MPage Doc Boundary – batches 

are broken into multi page TIFF 

files each time a level II blip is 

encountered on the film. (Only 

available when scanning blipped 

microfilm and if a MARS 

controller is connected to the 

scanner). 

 

Note: When this option is enabled 

and PDF output is chosen, the 

PDF file is automatically created 

for every Chapter (level II image 

address) on the film. 
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Renumber Renumbers all the pages in a batch 

to be in consecutive numerical 

order.  

 

This may be useful if a user has 

deleted a page in the batch, which 

would have given them 7.TIF, 

9.TIF and 10.TIF. Checking the 

renumber checkbox would result 

in the numerically correct 7.TIF, 

8.TIF and 9.TIF 

 

Max Pages Defines the maximum number of 

pages that any multipage TIFF file 

may consist of. 

 

Note: If this setting is lower than 

the Count setting in Batch 

Subdirs by then Count is 

overridden and each sub-directory 

may contain more than one 

multipage TIFF.  In contrast, if the 

Count setting is less than the Max 

Pages setting, each multipage 

TIFF file will be the size of Count. 

 

Uploading to Kofax Ascent 

The PowerFilm Kofax Ascent Uploader is an additional cost 

option for PowerFilm (Kofax Ascent versions 5 to 7.5). 

Once this software is installed, an additional option (Kofax 

Ascent) will appear in the Format pick list on the PowerFilm 

batch tab. 

The following applies when using the 'Kofax Ascent' format 

option: 

 



 

PowerFilm User Manual 5-24 

1. Kofax Ascent version 5 (or above) must be installed 

on the same PC as PowerFilm.  If Ascent is not 

detected an error message is displayed. 

2. The PowerFilm configuration name must match the 

name of the target Kofax Ascent Batch Class 

otherwise an error will occur the batch will not be 

uploaded to Ascent. 

3. Any PowerFilm index fields configured on the Index 

tab are mapped to Ascent fields of the same name. 

4. In addition, the target Ascent Document class must 

include the following field names: 

 

 Level1ImageAddress 

 Level2ImageAddress 

 Level3ImageAddress 

 Date 

 Time 

 

If these fields do not exist then the imported batch will be 

sent to the Ascent QA process after import. 

 

5. The PowerFilm format types; 'Single Document', 

'MPage Doc per batch' and 'MPage Doc Boundary', 

all create single page tiff files.  Multipage tiff files 

are not supported by the Ascent import process. 

6. When the format type is set to 'Single Document', 

each image file scanned will become a separate 

document in Ascent. 

7. An import log file is automatically created (default 

c:\acmxmlail.txt).  This file should be checked after 

each import session to ensure that the import was 

successful. 

8. Note that PowerFilm batches are not removed from 

the file system even after successful import to 

Ascent. They should be purged once it is confirmed 

that import to Ascent was successful. 

9. If you are using Kofax User Profiles, the Batch 

Classes relating to PowerFilm need to be assigned to 

the same User ID – that User ID is then hardcoded 

into the Windows Registry string „Kofax Options‟ in 
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the PowerFilm section (HKLM).  We currently use –

n –v (n causes rejected batches to be passed to the 

QA module; v causes more information to be written 

to the XML auto import log), so you  need to add –

u:”UserID” and –p:”Password” to the registry string 

to match the Kofax User profile username and 

password to be used. 

10. There is currently no way to interact with the Kofax 

User Profiles to set the user identity and Batch 

Classes to be used dynamically. 

Kofax Ascent Form Type Support 

From v5.4, PowerFilm supports the specification of Form 

Types when uploading batches to Kofax Ascent.  This is 

necessary if more than one Form Type has been defined in 

the target Ascent Batch/Document classes.   

The PowerFilm Configuration name is set to match the target 

Ascent Batch Class.  

 

This works fine if only one Ascent Form Type has been 

defined for the Ascent Document class within „Ascent Test 

Batch Class‟. 

 If you need to explicitly define the appropriate Ascent Form 

Type, you should include it in the name of the PowerFilm 

Configuration in the following format: 

BatchClassName FT FormTypeName 

Note the space either side of „FT‟. 
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Image Control Tab 

The Image Control Tab allows the user to define Image Sizes, 

Image Attributes, and Brightness and Contrast settings. 

 

 

The Image Control Tab consists of the following sections. 

 
 

Fig 6. The Image Control Tab 
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Image Mode 

The Image Mode options setup the scan area, image sizes and 

orientation of the image(s) to be scanned. 

 

Configuration Centre Scan Mode - Scans the 

centre of the view screen in an 

area designated by the image size 

selected.  This is the only 

configuration that will allow you 

to select Landscape image sizes. 

 

Left Scan Mode - Not available 

on the 2400DSV-E, 2400 DV 

Plus. 

 

Scans the left portion of the 

3000DSV-E, 3000 DV Plus view 

screen in the image size selected.   

 

Right Scan Mode – Not available 

on the 2400DSV-E, 2400 DV 

Plus. 

 

Scans the right portion of the 

3000DSV-E, 3000 DV Plus view 

screen in the image size selected. 

 

Duplex – Not available on the 

2400DSV-E, 2400 DV Plus. 

 

Scans the left and right portions of 

the 3000DSV-E, 3000 DV Plus 

view screen separately - in the 

image size selected - resulting in 

two separate images. 
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 Duplex Custom – Allows users to 

define a custom size for the 

Duplex images. .  The image size 

should be set to the required size 

of the individual images which 

will be less that the maximum size 

of the left or right portions of the 

3000DSV-E, 3000 DV Plus view 

screen.  When “Duplex Custom” 

is selected “Image Size” changes 

to “Custom Front” 

 

Full Screen Mode - Scans the 

entire 17” x 11” of the 3000DSV-

E, 3000 DV Plus view screen.  

The image size is fixed to 17” x 

11”.   

 

Full Screen Mode on the 

2400DSV-E, 3000 DV Plus 

results in a maximum scan area of 

300mm x 300mm. 

 

When this mode is selected the 

MARS Controller will be 

instructed to advance two frames 

for each scan instead of one. 

 

 Cheque Film (Single) - Not 

available on the 2400DSV-E, 

2400 DV Plus. 

 

Scans both the front and back of 

the cheque in one operation 

resulting in one image containing 

both sides of the cheque side by 

side. 
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 Cheque Film (Dual) - Not 

available on the 2400DSV-E, 

2400 DV Plus. 

 

Scans the front of the cheque and 

then scans the back side resulting 

in two separate images. 
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Image Size Allows the user to define the 

image size to be scanned in the 

defined configuration mode. 

 

When Left, Right or Duplex 

modes are set the image size 

options are limited to sizes that 

will fit in the left or right portions 

of the viewing screen. 

 

When Custom size is selected the 

Left, Top, Width and Height 

parameter boxes appear.  The user 

can configure custom image sizes 

by directly typing values into 

these boxes - within the 

boundaries of the configuration 

mode selected.  If an invalid size 

is entered the value will reset to 

maximum size for that field. 

 

Note: The Top parameter on the 

3000DSV-E, 3000 DV Plus can be 

confusing as this is actually the 

distance from the bottom of the 

3000DSV-E, 3000 DV Plus screen 

to the bottom edge of the image. 

 

Alternatively, after pressing Set 

Size, you can use the mouse to 

„rubber band‟ an area of the 

maximum scan size to use as the 

custom size.  See section Setting 

Image Sizes for more information. 

 

 



 

PowerFilm User Manual 5-32 

Set Size Button 

 

Only appears when the 

Configuration is set to Custom 

Duplex or the Image Size is set to 

Custom. 

 

The maximum scan size is 

scanned and displayed in the 

image viewer and the Set Size 

button changes to Fix Size. 

 

Note: the maximum scan size is 

reduced at 800DPI.  The 

maximum with of scan area is 

220mm. 

 

Fix Size Button After setting the custom image 

size using the rubber band 

method, use the Fix Size button to 

apply the new custom size 

parameters.  

 

After Fix Size is pressed, the new 

image size will be scanned and 

will appear in the image viewer as 

a browsed image.  Browsed 

images are discarded as soon as 

normal scanning is resumed. 

 

Rotation Allows the user to define the 

required rotation for images 

scanned using this configuration. 

 

For example, if landscape images 

were stored on the film in portrait 

orientation, setting the Rotation to 

90° Left will view and save the 

images in landscape. 
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Image Attributes 

The Image Mode options allow the user to define the image 

attributes that should be used to store images scanned with 

the current configuration. 

 

Resolution (DPI) Sets the scanned image resolution 

measured in Dots Per Inch (DPI).  

Choices are 200, 300, 400, 600 or 

800 DPI. 

 

Composition Allows the user to select how 

various shades of gray will be 

displayed and saved when the 

image is scanned. 

 

Fine Mode 1 - The image will 

contain minor amounts of gray 

scaling. 

 

Fine Mode 2 - The image will 

contain only black and white 

pixels; small speckles will be 

removed.  This setting usually 

creates the smallest image files. 

 

Text - Pure bitonal black and 

white only. 

 

Picture - The image will be 

displayed and saved with a best 

interpretation of the shades of 

gray in the original document. 
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Compression Reduces the file size of scanned 

images by replacing redundant 

image data with some smaller 

representation of that data.  Select 

the type of image compression 

required.  Group 4 is the default. 

 

 None - No compression. 

. 

 Group 3-1D - Compresses each 

scan line individually. 

 

 Group 3-2D - Compresses a 

reference scan line like in Group 

3-1D compression.  For the next 

scan line, 2D compression stores 

only the pixel values that differ 

between the new line and the 

reference line 

 

 Group 4 - Also called Group 4-

2D.  This is the most commonly 

used compression. 
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Save As Allows the user to define how the 

image is saved. 

 

Black and White - Saves the 

image in bitonal composition. 

 

Greyscale – Greyscale support 

board option for DSV/DV Plus 

scanners only.  

 

PowerFilm will automatically 

detect the presence of the 

greyscale board in the scanner and 

enable 'Greyscale' as a 'Save as' 

option on the Image tab.  

 

On Windows 2000 users may 

choose to compress Greyscale 

images using JPEG or LZW 

compression.  

 

Note: The presence of a Greyscale 

board is displayed on the About 

option from the Help Menu 

  

Brightness 

Sets the reflectivity of the image, including both light and 

dark areas.  Generally, lower Brightness settings will lighten 

the overall image. 

Note: If Auto Exposure is enabled on the Options Control 

Tab the Brightness section will indicate “Brightness (Auto 

Exposure)” instead of “Brightness (Manual)” and the 

Brightness control will set the level of Auto Exposure. 
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Contrast 

Allows the scanner to detect subtle differences in gray scale 

levels at scan time.  Higher contrast levels generally produce 

cleaner images but lose some detail.  Low contrast levels 

produce noisy images, or images that appear smudged, but 

preserve the details. 

Setting Image Sizes 

PowerFilm allows you to easily define a custom image size 

that may be saved in a recallable configuration. 

Although image sizes may be configured manually by typing 

values directly into the Left, Top, Width and Height parameter 

boxes, it is by far easier to use the mouse to „rubber band‟ an 

area of the maximum scan area that should be used as the 

custom size. 
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To Set a Custom Image Size 

1. Select the appropriate Image Configuration Mode and 

then select “Custom” as the Image Size. 

2. Press the Set Size button – the maximum scan area (for 

the Configuration Mode selected)  is scanned and 

displayed. 

3. Use the mouse to „rubber band‟ an area around the 

image you are nominating for a custom size. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. As you release the mouse the Left, Top, Width and 

Height parameter boxes are automatically populated. 

5. Press Fix Size to apply the new custom size parameters. 

After Fix Size is pressed, the new image size will be scanned 

and will appear in the image viewer as a browsed image.  

 
 

Fig 7. Setting an Image Size using ‘Rubber Banding’ 
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Browsed images are discarded as soon as normal scanning is 

resumed. 

Note: When using the “rubber band” technique to setup 

custom sizes on the 2400DSV-E, 2400 DV Plus, Left and 

Top co-ordinates are ignored as the 2400DSV-E, 2400 DV 

Plus centres all images.   Be aware that you are actually 

configuring custom Width and Height only. 

Duplex Scanning 

When the Image Mode Configuration is set to Duplex, the 

left and right portions of the 3000DSV-E, 3000 DV Plus view 

screens are scanned separately - in the image size selected - 

resulting in two separate images 

Custom Duplex Image Sizes 

PowerFilm allows users to select „Custom Back‟ as well as 

„Custom Front‟ in the image size pick list.  Custom paper 

sizes and orientations for the front and the back images can 

therefore be setup independently (see note below) using the 

„rubber band‟ method. 

Note:  The 3000DSV-E, 3000 DV Plus scanner cannot accept 

different height and width sizes for the front and back 

images, therefore PowerFilm will apply the height and width 

parameters setup for the front image to the back image.  This 

allows users to apply different top and left coordinates to the 

front and back images to deal with small alignment and skew 

differences between the front and back images on the film.  

Users should ensure that they rubber band a big enough area 

around the front image to deal with the expected skew on the 

back image.  Auto Masking may then be used to mask the 

black borders. 

To configure the image sizes and orientation for Custom 

Duplex paper sizes (3000DSV-E, 3000 DV Plus): 
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Ensure that the front image is aligned in the left portion of the 

3000DSV-E, 3000 DV Plus viewing screen and that the back 

image is aligned in the right portion. 

1. Select "Duplex Custom" as the Image Mode 

Configuration. 

2. Select Custom Front. 

3. Press Set Size. The max scan area for the left portion of 

the screen is scanned. 

4. Rubber band the area for the Front image. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Press Fix Size.  The new scan size is displayed. 

6. Select the desired orientation for the Front image. 

7. Select Custom Back. 

8. Press Set Size.  The max scan area for the right portion 

of the screen is scanned. 

9. Rubber band the area for the Back image. 

 

 
 

Fig 8. Setting an Image Size for Duplex Film 
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10. Press Set Size.  The new scan size is displayed. 

11. Select the desired orientation for the Back image. 

12. Save the configuration if appropriate. 

13. Begin scanning as normal. 

If you have defined TOP and LEFT coordinates for the back 

image that would cause the WIDTH and HEIGHT of the 

image (setup in Custom Front) to exceed the maximum scan 

area for the back image, you will receive an error message 

(when you attempt to begin normal scanning) indicating that 

the front and back image sizes are incompatible.  If this 

occurs, reconfigure your Custom Front and Custom Back 

image sizes appropriately. 

Duplex Custom (Merge) 

Setup for Duplex Custom (Merge) is the same as for „Duplex 

Custom‟ above.  However, instead of creating two images 

(front and back) as each frame is scanned, PowerFilm will 

Merge the front and back images into a single image.  The 

left image (as displayed in the 3000DSV-E, 3000 DV Plus 

viewer) will appear above the right image.  PowerFilm will 

insert a small amount of white space between the images.  

The amount of white space inserted should be sufficient for 

most requirements, but is also controllable by the registry 

setting - "Merge Gap". 

Note: Merging images together is a very CPU intensive 

process and may take some time for large image areas 

especially at image resolutions higher than 200 dpi. 

Duplex Scanning with the 2400DSV-E, 2400 
DV Plus 

Although the 2400DSV-E, 2400 DV Plus scanner does not 

have right and left areas on the scanner view screen, it is still 

possible to emulate a duplex configuration.  The setup 

procedure is identical to that of the 3000DSV-E, 3000 DV 

Plus with the following exceptions: 
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1. When you press „Set Size‟ for Custom Front OR Custom 

Back, a full screen scan is performed.  You are able to 

„rubber band‟ different areas for the front and back from 

the full screen scan. 

2. Unlike the 3000DSV-E, 3000 DV Plus, the scan areas for 

the front and back images, defined with the „rubber 

band‟ technique, may be different sizes. 
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Options Tab 

The Options Tab allows the user to setup scanner specific 

options and features. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Options Control Tab consists of the following sections. 

 
 

Fig 9. The Options Control Tab 
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Photo Interpretation 

These radio buttons allow the user to select whether the dark 

and light areas of the image should be reversed when the 

image is scanned. 

 

Positive - Positive Scans the image as it appears on 

the scanner‟s view screen.  Light 

areas appear light and dark areas 

appear dark. 

 

Negative – Positive Scan the image and reverses the 

light and dark areas.  Areas that 

appear light on the scanners view 

screen appear dark and dark areas 

appear light. 

 

Auto Allow the scanner to 

automatically determine the photo 

interpretation setting. 

 

Reverse Image Changes all black pixels to white 

and all white pixels to black. 

 

Options 

These check boxes enable or disable some of the 3000DSV-

E, 3000 DV Plus and 2400DSV-E, 2400 DV Plus specific 

functionality. 

 

Auto Eliminate Frame 

 

Removes black borders from the 

edges of images, which result 

from having space between the 

edges of the document and the 

boundaries of the scan area.   
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Auto Masking Masks any heavy black borders on 

the image.  When Auto Masking 

is enabled the black areas are 

replaced with white areas. 

 

Centering Centering automatically centres 

the scanned image inside the 

defined image size. 

 

Auto Masking must be enabled 

before Centering can be selected. 

 

Auto Focus Not available on the 2400DSV-E, 

2400 DV Plus. 

 

Instructs the 3000DSV-E, 3000 

DV Plus to automatically focus to 

the first image scanned in the 

current scan session. 

 

Check the About option on the 

Help menu to check firmware 

revisions and what options are 

fitted in the scanner that have been 

detected by PowerFilm. 

 

Note: The Auto Focus option kit 

must be fitted in the scanner for 

Auto Focus to be enabled.  The 

firmware revision of the scanner 

should be 5-22 or above. 

 

Note: Setting Auto Focus on will 

significantly increase the scanning 

time. 
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Deskew Instructs the scanner to Deskew 

all images scanned. 

 

Check the About option on the 

Help menu to check firmware 

revisions and what options are 

fitted in the Scanner that have 

been detected by PowerFilm. 

 

 Note: The Deskew option kit and 

the Auto Focus option kit must be 

fitted in the scanner for Deskew to 

be enabled.  If you are using a 

3000DSV-E, 3000 DV Plus the 

firmware revision must be 5-22 or 

above. 

 

Note: Setting Deskew on will 

significantly increase the scanning 

time. 

 

Auto Exposure When Auto Exposure is enabled 

the Brightness section on the 

Image Control Tab will indicate 

“Brightness (Auto Exposure)” 

instead of “Brightness (Manual)” 

and the Brightness control will set 

the level of Auto Exposure. 
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Scan to Printer Sets PowerFilm into Reader 

Printer mode.  Images are 

displayed as they are printed but 

not saved. 

 

Navigate to the first image that 

you wish to start printing from, 

select the desired range of images 

or batches and press the Scan 

button. 

 

 

Note: PowerFilm will print to the 

last printer used when manually 

printing images from a scanned 

batch.  See Chapter 7 - Mail, 

Print, Fax Integration for more 

information. 

 

Note: If images from a scanned 

batch have never been printed, 

PowerFilm will ask you to define 

the printer you wish to use in 

Scan to Printer mode. 
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Blank Page Threshold Users specify a maximum value at 

which every image whose size 

(measure in bytes) is 

automatically dropped from the 

batch. This will be particularly 

useful if users are dealing with 

film that is known to have a lot of 

blank pages. 

 

Drag the range bar or input a 

minimum byte count. 

  

Caution: Users should be aware 

that Image Tab settings, such as 

image size, resolution and 

compression, will dramatically 

affect the size (in bytes) of each 

image. In the long run it will be 

beneficial to carry out a few tests 

to decide a suitable blank page 

threshold. 
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Using Configurations 
This section covers the use of the PowerFilm recallable 

Configurations. 

All of the parameters that are configurable on any of the 

Control Tabs may be saved in user defined configurations. 

Creating new configurations, saving changes to existing 

configurations, deleting existing configurations, renaming 

configurations and saving an existing configuration as a new 

configuration all require the Supervisor Password and are 

covered in Chapter 6 System Administration. 

Users may make any necessary changes to any of the 

parameters on any of the Control Tabs (with the exception of 

any indexing schemes setup on the Index Control Tab) in any 

scan session, but these changes will not be saved when 

PowerFilm is closed or when a new configuration is opened.  

Note: If you do make changes to any Control Tab 

parameters you would normally be prompted to 

enter the Supervisors Password and save the changes 

when you exit PowerFilm or open any other 

configurations.  However, it is possible to disable 

this prompt from an options setup screen.  See 

Chapter 6 System Administration for further details. 

Note: PowerFilm will remember the last configuration that 

was in use when the program is restarted. 

To Open a Configuration 

When an existing configuration is opened, PowerFilm 

retrieves all the associated parameters and settings.  Follow 

these procedures to open an existing configuration. 
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1.   Select Open Configuration from the 

Configuration menu. 

The Open Configuration dialog displays (Fig 6.). 

2.   Select the configuration you want to use. 

The selection is highlighted. 

3.   Click on OK or press ENTER. 

The PowerFilm title bar reflects the name of the 

configuration and the selected configuration is 

ready to use for scanning. 

Using Indexing 
This section explains the use of existing indexing Control 

Tab configurations.  The actual setup of indexing schemes is 

discussed in Chapter 6 System Administration. 

 
 

Fig 10. The Open Configuration Dialog 
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The Index Control Tab allows the user to enter indexing data 

that may be linked to each image or range of images in a 

batch.  The indexing data may then be exported in *.IDX 

format, for further processing in the CDPublish and 

CDRetrieve software packages, or in comma delimited 

*.CSV format. 

 Index Fields 

The index fields are where you enter the data that you would 

like to relate to the image or range of images that will be 

scanned. 

 
 

Fig 11. Adding Index Information 
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Some index fields may have been defined as mandatory or 

require specific data formats.  If you do not enter a mandatory 

field or the data is not of the correct format PowerFilm will 

display a warning message. 

New Index Button 

The New Index Button clears the current values in the index 

fields and restores any default values that may have been 

defined in indexing setup. 

Applying Indexing Data during 
Scanning 

To add the same indexing data to a range of images as they 

are scanned: 

1. Open a configuration that contains the appropriate 

Indexing scheme. 

2. Select the Indexing Control Tab. 

3. Enter the required data in the appropriate indexing fields.  

4. Begin scanning the image or range of images as required.  

The Index data will be applied to each image as it is scanned. 

Reviewing/Changing Index Data 

Until a batch is closed, it is possible to amend previously 

entered index values using the page navigation buttons above 

the image window. 

While the batch is open the page navigation buttons will 

allow you to move backwards and forwards in a batch.  As 

you move through a batch in this way the index data on the 

Index Control Tab will update to reflect the index data for the 

currently viewed page.  If you need to amend the data for a 
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particular image, simply change the index data while that 

image is displayed. 

It is also possible to switch between images by selecting the 

appropriate image in the viewer window. This is only 

possible if the view is set to “Show 2 Viewers”, “Show 4 

Viewers” or “Show 6 Viewers” at a time. 

Note: When scanning is resumed, the index values 

currently displayed will be applied to the new 

images.  If you wish to apply different index 

values press the New Index button.  This will 

save the index values for the currently viewed 

image and clear the index fields or reset them 

back to default values, if these have been 

defined. 

Caution: If you press the New Index button and then 

navigate forward or backwards in the batch, the 

New Index values (which may be blank) will be 

applied to the image you were viewing before 

pressing the navigation buttons. 
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Indexing/Loading Previously 
Scanned Batches 

PowerFilm allows you to open previously scanned batches 

even if you do not have a scanner attached.  This can be 

useful if you want offload the index process to a later time or 

to different operators. 

Users are able to view and index the images in a previously 

scanned batch as well as Print, Fax and Email individual 

images or ranges of images. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Fig 12. Indexing Previously Scanned Batches 
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Loading the Batch 

1. From the File Menu, select Load Batch. 

The Load Batch dialog appears. 

2. Navigate to the batch you want to open.  Open 

either a CDPublish compatible *.IDX file or a 

Comma Delimited *.CSV file and press OK. 

All Control Tabs other that the Index Control Tab 

are removed, the Scan button on the button bar is 

also removed 

Note: The batch is opened using the same configuration 

that was used to create it.  The configuration and the 

path to the batch and configuration file are displayed 

on the Windows Title Bar. 

The user is now able to add or update the index values for 

any of the images displayed. 

Note Users are also able to save the images in alternative 

Compression Types and Gray scale compositions to 

the values assigned when the images were scanned. 

  It is also possible to export the index data in the 

alternative format. E.g. if a *.IDX file was loaded it 

may be saved as a *.CSV file. 

Carrying Over Field Values 

Users may choose to carry field values over to subsequent 

images in the batch by enabling the check box adjacent to the 

field. 
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If subsequent fields already have values assigned to them, the 

user may choose to overwrite the existing value by enabling 

the Force Overwrite check box. 

 

 

Navigating in Multipage TIFF Batches 

If the batch consists of a number of multipage TIFF files, 

additional controls on the page navigation button bar will be 

enabled. 

 

 

 

For batches that contain multipage TIFF files, the number 

indicates the position of the multipage TIFF file in the batch. 

The Up and Down arrows allow you to navigate inside the 

multpage TIFF file. 

The Left and Right arrows allow you to move forward and 

backwards in the batch one multipage TIFF file at a time.  

Page Up and Page Down on the keyboard may be used as an 

alternative. 

The status bar will indicate your current position within the 

batch and the current multipage TIFF.  For example: 

 

 

 

Indexing in Multipage TIFF Batches 

Note that only the index values assigned to the first image in 

a multipage TIFF file are saved in the index data files (.IDX 

or .CSV). 
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Printing, Faxing and Emailing in Multipage 
TIFF Batches 

Having opened a batch that contains multipage TIFF files, 

you are able to Print, Fax or Email the TIFF files.  However 

you cannot select to Print, Fax or Email individual pages 

within a multipage TIFF file. 

Closing the Batch 

Once you have completed indexing the batch press the Close 

Batch button on the button bar to close the batch and export 

the index data in the selected format. 

Batch Import Feature 
PowerFilm provides a facility to import a batch of scanned 

TIFF files into PowerFilm and continue scanning into it.  

This has two benefits; 1) PowerFilm can now add to a batch 

of images scanned by another system, and 2) a batch of 

images scanned with PowerFilm (that was not suspended) can 

be imported and the user can continue scanning into it. 

The following rules apply: 

1. Only batches comprised of single page TIFF files (G4) are 

supported.  Multipage TIFF files are not supported. 

2. The import folder must contain ONLY *.tif files.  If the 

batch was created by PowerFilm, the PowerFilm IDX and 

CFG files must be removed before the images may be 

imported. 

3. The images must have a suffix (before the .tif file 

extension) representing the numeric number sequence of 

the files.  A prefix of up to 4 characters is also supported.  

This prefix will override the prefix in the PowerFilm 

configuration after the batch is successfully imported.  

There can be a break in the number sequence.  If the 

Renumber option is enabled, the images will be 

renumbered when they are saved in PowerFilm.  An 
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example of a supported image file name format is 

„IMG00001.tif‟, „IMG00002.tif‟, etc.  Numbering must 

begin with a number greater than „0‟.  „IMG00000.tif‟ will 

not be imported. 

4. The configuration on the Batch tab should be set before 

importing the batch.  For example, if you are importing a 

batch of single page TIFF images and you intend to save 

them as a multipage TIFF, ensure that the output type is 

set to Mpage in the Output Options before importing the 

batch. 

5. If you reject a batch that was imported, the images are 

NOT deleted. 



 

PowerFilm User Manual 5-58 

Using Annotations 
PowerFilm allows you to highlight a particular area of an 

image, blank out information on an image or add a note to an 

image before printing, faxing, emailing or saving to the batch. 

You can use this feature to mask confidential information or 

add a customer message on a requested image. 

Annotation Toolbar 

To launch the annotation toolbar select the Annotation 

Menu and choose Show Annotation Toolbar. This brings 

up the following toolbar: 

 

The Annotation Toolbar 

This toolbar contains various annotation options.  

 

 
Select Annotations and Zones. 

This allows the user to select any 

previously created annotations so 

it can be moved, resized, deleted 

or to modify its properties.  

Note: You are not able to reselect 

Burned-in annotations. 

 

 
Freehand Line. This allows the 

user to create free-form lines. This 

could be used to call attention to 

something specific on an image.  
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Highlighter. This allows the user 

to draw a rectangle highlighting a 

specific area with a transparent 

colour. This could be used to call 

attention to something specific on 

an image. 

 

 
Straight Line. This allows the 

user to draw straight lines. This 

could be used to call attention to 

something specific on an image. 

 

 
Hollow Rectangle. Allows the 

user to draw a rectangular border 

around a specific area on an 

image. 

 

 
Filled Rectangle. Allows the user 

to draw a filled-in rectangle 

around a specific area on an 

image. 

 

 
Text. Allows the user to type a 

text message to be added to the 

image.  

 

To modify font size, font colour 

and background properties, ensure 

that the Select Annotation tool is 

chosen and then right-click your 

annotation.  This will bring up a 

mini menu that allows you to 

modify the annotation 
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Attach-a-Note. Allows the user to 

attach various notes to an image. 

Text is displayed on a yellow 

background. 

 

To modify colours and fonts 

ensure the Select Annotation tool 

is chosen and then right-click your 

annotation.  This will bring up a 

mini menu that allows you to 

modify the annotation 

 

Adding Annotations 

To add an annotation, launch the Annotation Toolbar by 

choosing Annotation Toolbar from the Annotation Menu. 

Now select your annotation type (refer to the list above) and 

add them to your image. It is possible to modify font and 

background properties, if appropriate as well as resize 

annotations by dragging the edges of the images as required. 

Once you have made all annotations to each image you need 

to make them permanent. Choose Burn In Annotations from 

the Annotation Menu to do this.  

Note: This operation is permanent and cannot be undone. 

Editing Annotations 

You are able to edit the characteristics of an annotation such 

as the background colour, pen colours and text styles.  To edit 

an Annotation, choose the Select Annotation  tool and 

right-click on the desired annotation with the mouse.  A mini 

menu will appear to allow you to choose which aspect of the 

annotations characteristics you would like to change. 
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Annotation characteristics editing options 

Note: It is not possible to edit an annotation that has already been 

“burned in”. 

Deleting Annotations 

To delete an Annotation, use the Select Annotation  tool 

and right-click the desired annotation with the mouse.  

Choose Delete from the mini menu. 

Or choose Delete Selected Annotations from the 

Annotation Menu. 
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Viewing Options 
PowerFilm allows you to define which images should be 

displayed in the image viewer window. 

From the View menu select Options. 

If Show by is set to Frame then the PowerFilm image viewer 

will show every nth image as defined in the Show Every box. 

If Show by is set to Batch then the PowerFilm image viewer 

will show the first page of every nth batch as defined in the 

Show Every box.  The first page of the current batch being 

scanned will be displayed in the image viewer until the next 

batch is scanned.  This can be useful if you have told 

 
 

Fig. 13 Image Viewer Viewing Options 
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PowerFilm to scan the entire film and you need to know the 

details of the batch currently being scanned. 

If Show by is set to Block then the PowerFilm image viewer 

will show the first page of every nth block as defined in the 

Show Every box.  The first page of the current block being 

scanned will be displayed in the image viewer until the next 

block is scanned.  This can be useful if you have told 

PowerFilm to scan the entire film and you need to know the 

details of the block currently being scanned. 

Note: The PowerFilm Viewing Options are not tied to 

configurations but are applied system wide. 

The Scanning Process 
This section discusses a typical scanning scenario and the 

setup and configuration parameters applied. 

To Scan a Document: 

Assuming that you have a MARS Controller attached to the 

scanner and you want to scan the third batch on a Dual level 

16mm film. 

1. Load PowerFilm according to the directions. 

The PowerFilm main screen is displayed. 

If necessary, open or create a configuration. 

Note: Whatever configuration was active when PowerFilm 

was last in use is the configuration that displays the 

next time PowerFilm is loaded.  The active 

configuration name displays in the Windows title 

bar. 

2. Change any Control Tab parameters as required. 
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3. Select the correct Blip Configuration on the Film 

Control Tab and press Setup Film. 

4. Load the film roll into the carrier.   

5. In the Film Control Tab press Goto Start. 

 

The scanner will display the first frame on the film. 

6. In the Film Control Tab under the Search section, 

select „3‟ in the Batch Box and „0‟ in the Frame Box. 

7. Press Search. 

8. Verify that the film has moved to the first frame in 

batch 3. 

9. In the Microfilm Control section of the Film Control 

Tab select Scan Next - 1 Batches. 

10. Click on the Scan button on the button bar. 

 

The Green light on the Scan button will change to 

Amber. 

All the images in batch 3 will be scanned. 

11. If Batch 3 is the only batch that you want to scan 

into this PowerFilm batch then click on the Close 

Batch button on the button bar. 

 
 

Fig 14. The Accept Batch Dialog Box 
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The Accept Batch dialog displays. 
 

Accept 

 

If the batch is accepted, an *.IDX 

file (or a *.CSV file) is created in 

a sub directory under the selected 

Base Directory. 

 

The Amber light on the Scan 

button will change back to Green. 

 

Suspend 

 

Suspend a batch without accepting 

it.  This allows you to re-open a 

batch at a later date and continue 

scanning into it.  The Suspend 

function creates a *.SUS file that 

can be recalled at any time in the 

future. It is comprised of the name 

of the configuration and date and 

time stamp, for example “A4 

Duplex 22-10-2001 12.17.55.sus”. 

This can be useful if scanning a 

large batch. 

 

You may choose to recall the 

batch at any time by selecting 

“Load Suspended Batch” from the 

File Menu. 

 

Reject The Batch is rejected and deleted 

from the directory structure. 

 

The Amber light on the Scan 

button will change back to Green. 

 

Continue Returns you to where you were 

before Close Batch was pressed. 
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Insert Scanning 
Users are able to choose to insert pages into the middle of a 

batch rather than append pages to the end of the batch during 

scanning.  New menu items; Insert Pages and Append 

Pages have been added to the Action menu.  The default is 

Append Pages.  This new feature allows users to scan 

images anywhere in an open batch to insert images that may 

have been missed when the batch was originally scanned. 

When Insert Pages is chosen, images are inserted 

immediately after the currently selected image in the 

PowerFilm image viewer. 

PowerFilm will revert to Append Pages when the program is 

restarted. 

Image Merge Function 
When more than one image has been scanned, this option 

merges the currently selected image underneath the previous 

image.  The second image is then discarded. 

This feature is especially useful on the 2400DSV-E, 2400 DV 

Plus scanner.  With the 2400DSV-E, 2400 DV Plus, the 

standard 'Custom Duplex (Merge)' functionality may result in 

a low definition merged image because the user needs to 

zoom out to a high degree to fit front and back images into 

the scanner display screen at the same time.  The 'Merge with 

previous page' functionality allows the user to scan the front 

image fully zoomed in to obtain maximum image definition, 

then scan the back image, then merge the two together.  The 

result is a high definition merged image.  To use this feature: 



 

Chapter 5 Control and Operation  5-67 5-67 

1. Scan two images. 

2. From the Action menu, choose Merge with 

Previous Page. 

The second image scanned is merged underneath the first 

image scanned and the batch only contains one image.  A 

small area of white space separates the two images. 

 
 

Fig. 15. Two Images Scanned 

 
 

Fig. 16. Images 1 and 2 Merged 
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Rescanning images 

While a batch is still open, PowerFilm allows you to rescan a 

new image over the top of a previously scanned image. 

To rescan an Image: 

1. Position the PowerFilm image viewer on the image in the 

batch that you wish to rescan. 

2. Use the Navigation controls on the Film Tab to move to 

the image you wish to rescan. 

3. Press the Rescan button on the button bar.  

4. The new image is scanned over the old 

image and replaces it in the batch. 

Rescanning with Duplex Film 

Rescanning with Duplex Film works the same way as for 

Simplex film except that you need to specify whether you 

want to rescan the front or the back image. 

1. As the previously scanned front and back images are 

already stored in the batch as separate images you are 

able to position the PowerFilm image viewer on either 

the front or the back image that is to be rescanned. 

2. Use the Navigation controls on the Film Tab to move to 

the image you wish to rescan.  Select Left Scan mode or 

Right Scan mode to scan the front or back image as 

required. 

3. Press the Rescan button. 

4. The new front or back image is scanned over the old 

image and replaces it in the batch. 

Rescanning with ‘Duplex Custom’ or 
‘Duplex Custom (Merge)’ 

The Rescan function scans a single image over a previously 

scanned image currently displayed in the PowerFilm image 

viewer.  When the Rescan button is pressed when the 
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configuration type is set to "Duplex Custom", the factor that 

determines if the front or the back image is rescanned is the 

"Image Size" choice.  If the "Image Size" is set to "Custom 

Front", then the custom image size setup for the front image 

is rescanned over the currently displayed image.  If the 

"Image Size" is set to "Custom Back", then the custom image 

size setup for the back image is rescanned over the currently 

displayed image. 

When the Rescan button is pressed when the configuration 

type is „Duplex Custom (Merge)‟, both the front and back 

images are rescanned again and merged together to overwrite 

the currently displayed merged image. 

Batch Crash Recovery 

PowerFilm will automatically recover a batch after a system 

crash.  When PowerFilm is restarted, the user will be given 

the option to recover the batch.  The batch will be restored to 

the state it was in at the point of the crash.  

Batch Save progress is displayed on the status bar as a 

percentage value during this process. 
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Using the Scanner’s Front 
Panel Controls 

The 3000DSV-E, 3000 DV Plus and the 2400DSV-

E, 2400 DV Plus scanners have numerous control 

buttons on their front panels.  These buttons allow 

the user to define scan areas and adjust 

resolution/contrast and image compositions - 

bypassing the settings configured in the PowerFilm 

user interface. 

When the front panel Scan button is pressed, a scan 

is performed and the resultant image is passed to 

PowerFilm.  PowerFilm displays each image 

scanned in this way just as if the image was scanned 

via the PowerFilm user interface. 

This feature is particularly useful when fiche, jackets 

or 35mm roll film is being digitized and image size 

and composition continually requires adjustment. 

Note: None of the settings changed on the front 

panel of the scanner will be reflected in the 

PowerFilm user interface or saved in the 

PowerFilm configuration. 
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Chapter 6 System 
Administration 

Overview 
This Chapter discusses all the aspects of PowerFilm that are 

usually controlled by the system Supervisor. 

PowerFilm Option Configuration 
There are certain PowerFilm setup parameters that do not 

relate to configurations but that are essential for correct 

system performance.  This section discusses each of these 

setup parameters. 

The parameters are available via a special PowerFilm 

Options setup screen. 

To access the PowerFilm Options Setup select Options from 

the File menu. 

The following Tab Screen will appear. 

 

 



 

PowerFilm User Manual 6-2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The PowerFilm Options setup screen consists of four tabs 

which each setup related parameters; Confirmation, MARS, 

Password and Settings. 

Confirmation 

The Confirmations Tab contains a number of check boxes 

that allow you to configure PowerFilm to prompt the user for 

confirmation whenever they perform the specified activity.   

For example, when the user presses the Close Batch button 

on the button bar the Accept Batch dialog box will appear. 

 
 

Fig 1. The PowerFilm Options Setup Screen 
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If Confirmation on Accept Batch is turned on an additional 

dialog box will appear when the user presses the Accept 

button. 

Selecting Yes will Accept the batch; selecting No will return 

you to where you were before Close Batch was pressed. 

Confirmation Check Boxes 

There are six confirmation check boxes. 

 

Program Exit 

 

Prompts the user for confirmation 

when they attempt to close 

PowerFilm. 

 

Configuration Delete 

 

Prompts the user for confirmation 

when they attempt to delete a 

configuration. 

 

Accept Batch 

 

Prompts the user for confirmation 

when they accept a batch. 

 

Reject Batch 

 

Prompts the user for confirmation 

when they reject a batch. 

 

 
 

Fig 2. The Accept Batch Dialog Box 

 
 

Fig 3. The Accept Batch Confirmation Dialog Box 
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Save Image 

 

Prompts the user for confirmation 

that any changes they made to an 

image, including rotation, cut and 

paste, redaction, keep selected -

should be saved. 

 

Image Delete Prompts the user for confirmation 

that any images they attempted to 

delete from the batch should really 

be deleted. 
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Controller 

The Controller Tab contains the setup parameters that allow 

PowerFilm to communicate properly with the Mini MARS II, 

MARS IV or MRS Controllers. 

The PowerFilm MRS 60 Controller Software is a PowerFilm 

Option.  See the PowerFilm MRS 60 Controller Option 

Documentation for further details on setting up and using 

PowerFilm with this device. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Controller Tab contains seven sections. 

 
 

Fig 4. The MARS Option Setup Tab 
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Controller 

Select the type of controller you have installed; MARS II, 

MARS IV or MRS 60. 

MARS Options 
 

Count Starts at 0 

 

The MARS controller can be 

configured to start counting Frame 

level blips from 0 or from 1.  Set 

this option to match the setting in 

PowerFilm. 

 

Count Starts at 1 The MARS controller can be 

configured to start counting Frame 

level blips from 0 or from 1.  Set 

this option to match the setting in 

PowerFilm. 

Communications Port Specific Options 
 

COM Port Use the drop-down to set the 

COM port on your PC to which 

the MARS Controller is fitted. 

 

Baud Rate Set the Baud rate to communicate 

with the MARS Controller. 

 

Parity Set the Parity to communicate 

with the MARS Controller. 

 

Stop Length Set the Stop Length to 

communicate with the MARS 

Controller. 

 

Character Length Set the Character Length to 

communicate with the MARS 

Controller. 
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Password 

When PowerFilm was first started after installation you will 

have been prompted for a Software Serial Number and 

Supervisor Password.  The Password tab allows you change 

the password that was entered after installation and also 

allows you to define an application startup password, for 

greater control purposes. 

Supervisor Password  

Complete all three boxes. 

 

 

 

 

 

 

 

 

 

 

 

Please Enter the Supervisor 

Password 

 

Enter the current Supervisor 

Password. 

 

Please Enter the New 

Supervisor Password 

 

Enter the replacement 

Supervisor Password. 

 

Confirm the New Supervisor 

Password 

Re-enter the replacement 

Supervisor Password. 

 

Note: If you have misplaced your Supervisor Password 

please contact your PowerFilm support representative. 

 
 

Fig 5. Supervisor Password Setup 
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Application Startup Password 

For access control purposes, administrators are now able to 

define an application start up password that users must enter 

before they can use the software.   

 

 

 

 

 

 

 

 

 

To configure an application start-up password, follow this 

procedure: 

1. Enter the supervisor password (see above). 

2. Enable the Password required for application start 

check box. 

3. Enter and confirm the startup password and press OK. 

The next time a user restarts PowerFilm, the following box 

will appear prompting for the password in order to gain 

access to PowerFilm. 

 

 

 

 

 

 

 

 
 

Fig 6. Application Startup Password Setup 
 

 

 
 

Fig 7. Enter password dialog box 
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Enter the password and press OK to launch the program. 

Settings 

The Settings Option Tab consists of seven sections.  

Localisation 

PowerFilm supports a facility to translate all of the menus, 

dialog boxes, pick lists, and messages into alternative 

languages.  This section allows you to define that 

Localisation is required and which Localisation INI file 

should be used.  For more information on Localisation, see 

Chapter 8 Localisation. 

 

Localisation Required If this check box is enabled 

PowerFilm will attempt to load all 

menus, dialogs, pick lists and 

messages from the specified 

Localisation INI file. 

 

Local INI File Double click here and navigate to 

the required Localisation INI file. 

 

Fax Settings 

The Fax Settings section allows you to define whether or not 

Fax to third party Fax Management software, that integrates 

with Windows via the use of a fax print driver should be 

enabled. 

 

Enable Fax If this check box is not checked 

the Fax Button on the button bar 

will be disabled. 
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Clear Setting If Enable Fax checked, the first 

time a user sends an image(s) to 

print they will be prompted to 

select the fax print driver.  

PowerFilm will then remember 

that fax print driver for subsequent 

faxes.  Should you wish to select 

an alternative fax print driver in 

the future then the Clear Setting 

button should be pressed.  The 

next time you send a fax in this 

way PowerFilm will again prompt 

you for the fax print driver. 

Configuration 

When a user makes any changes to an existing configuration 

and then attempts to close PowerFilm or open an alternative 

configuration, PowerFilm, by default, will prompt them for 

the Supervisor Password.  The user simply chooses Cancel to 

ignore the changes; however, if the user has no intention of 

saving any changes this can become irritating.  For this 

reason PowerFilm provides the facility to turn off the prompt 

to enter the Supervisor password and save the changes. 

 

Prompt to Save the 

Configuration 

Un-check this check box if you do 

not want users prompted to enter 

the supervisor password and save 

the changes. 

Adobe PDF 

 

Max Tiffs The maximum amount of tiff 

pages that may be converted into a 

single PDF file.  See the Adobe 

PDF output documentation for 

further information. 
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Viewer Alignment 

This will decide how images appear in the image viewer. 

Choose between horizontally (film appears to move left and 

right) and vertically (film moves up and down). Vertical is 

the default setting. 

USB/SCSI 

Define how the scanner is attached to your PC. 

Note: The SCSI interface is not supported under Windows 

Vista or Windows 7. 

Functionality 

See Customisable User Interface, below. 

Customisable User Interface 
Administrators are able to enable/disable areas of the user 

interface that are not utilised or should be hidden from 

general users. 

All of the menus may be hidden, processing tabs that are not 

required may be hidden and you can even hide certain sub 

sections on any of the displayed processing tabs in order to 

provide the users with only the functionality that is required 

for their application of the software. 

This functionality allows PowerFilm to be tightly tailored to 

the users‟ requirements and therefore easier to apply to a 

given application.  This ultimately leads to simplified training 

and support requirements. 
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Accessing the Custom Functionality 
Settings 

A new section has been added to the Settings tab on the 

PowerFilm Options dialog.  Access the PowerFilm Options 

from the File menu in the main user interface. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Fig 8. Options Dialog 
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To access the custom functionality settings, press the Setup 

Functionality button.  You will be prompted to enter the 

Supervisor password.  Once you have entered the Supervisor 

Password, the Setup Functionality dialog will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Setup Functionality dialog consists of three tabs: 

 

The Menus tab deals with enabling/disabling the menus.  All 

of the menus in the user interface may be configured. 

The Buttons / Tabs / Misc tab deals with the 

enabling/disabling of the processing tabs and all the tool bar 

 
 

Fig 9.Setup Functionality Dialog 
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buttons.  This tab also contains a miscellaneous section to 

allow you to configure the following additional options: 

Display full path 

during scanning 

PowerFilm normally displays the 

full path to where the image files 

are being created on the status bar 

in the main user interface.  If this 

functionality is disabled, only the 

image file name is displayed. 

 

Allow Suspended 

Batch 

If this is disabled, users will not be 

able to choose to suspend a batch 

after scanning. 

 

Recover failed batch 

on startup 

If a crash occurs during scanning, 

PowerFilm will attempt to recover 

the batch the next time the program 

is started.  If this option is disabled, 

the user will not be prompted to 

recover crashed batches at startup. 

 

No supervisor 

password required 

for startup 

If this option is disabled, the user 

MUST enter the Supervisor 

Password to close PowerFilm.  

Only users that know the 

Supervisor password will be able to 

close the program. 

The Frames tab deals with the enabling/disabling of sub 

sections (known as frames) on each of the processing tabs 

that have been enabled.  If a processing tab has been disabled 

on the Buttons / Tabs / Misc tab, the section relating to the 

sub sections of that tab will be disabled here. 

On each of the tabs there are two buttons that allow you to 

quickly enable or disable all the options on each tab. 
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Note: Where „………….‟ appears on any of the tabs, this 

indicates either a menu or a button separator.  Separators can 

be enabled or disabled in the same way as menus and buttons. 

To Configure Custom Functionality 

1. Use the check boxes on each of the three tabs to enable only 

the desired functionality. 

2. Press the OK button to close the Setup Functionality dialog.  

A message will be displayed to indicate that the changes will 

not be effective until PowerFilm is restarted. 

3. On the PowerFilm Options dialog, enable the Limit 

Functionality checkbox. 

 

4. Close and restart PowerFilm. 

In the screen shot below, only the Batch, Image and Options 

processing tabs have been enabled.  The Image tab contains 

only the Brightness and Contrast sub sections.  The File and 

View menus are the only menus available (the Help menu is 

always available) and the user only has access to scan, print, 

image zoom and image rotate buttons. 
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Disabling the Custom Interface 

Once a custom interface has been defined and enabled, 

PowerFilm will always start in the custom mode.  To disable 

the custom interface at any time, choose Set into Admin 

mode from the Help menu.  You will be prompted for the 

Supervisor password.  Once the Supervisor password has 

been entered, PowerFilm will close.  When PowerFilm is 

restarted, the full interface will be displayed.  You are then 

able to change any of the default settings in the PowerFilm 

configuration as required and you can then re-enable the 

custom interface by selecting the Limit Functionality check 

box on the Settings tab of the PowerFilm Options dialog. 

 

 
 

Fig 10.Custom User Interface 
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Configuration and Setup of 
Configurations 

As discussed in Chapter 5 Control and Operation, users are 

able to open any pre-configured configurations. 

Users may make any necessary changes to any of the 

parameters on any of the Control Tabs (with the exception of 

any indexing schemes setup on the Index Control Tab) in any 

scan session, but these changes will not be saved when 

PowerFilm is closed or when a new configuration is opened.  

If the user does make changes to any Control Tab parameters 

they will normally be prompted to enter the Supervisor‟s 

Password and save the changes when they exit PowerFilm or 

open any other configurations.  However, it is possible to 

disable this prompt from the options setup screen.  See 

Settings above. 

Supervisors or users who know the supervisor password can 

create and save new configurations, save changes to existing 

configurations, delete existing configurations and save 

existing configurations as a new configuration with a new 

name. 

Creating a New Configuration 

1. From the Configuration menu select New 

Configuration.  

The Enter Supervisor Password dialog appears. 

2. Enter the Supervisor Password. 

 

You are prompted for the name for the new 

configuration. 
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3. Enter a unique name. 

Note: You will receive an error message if 

you enter a configuration name that 

already exists. 

4. Press OK. 

The new configuration opens and the configuration name 

appears on the Windows title bar. 

You can now make any necessary changes to the new 

configuration and save them.  See Saving Configurations 

below. 

Saving Changes to Existing 
Configurations 

1. From the Configuration menu select Save. 

or press  on the button bar above the Control Tabs. 

You are prompted for the Supervisor‟s Password to save 

the configuration. 

2. Enter the Supervisor‟s Password and press OK. 

The configuration is now saved. 

Deleting Existing Configurations 

1. Open the Configuration you wish to delete. 

2. From the Configuration menu select Delete 

Configuration. 
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You are prompted for the Supervisor‟s Password to 

delete the configuration. 

3. Enter the Supervisor‟s Password and press OK. 

The configuration is now deleted. 

Saving Existing Configurations as a 
New Configuration with a New Name 

1. Open the configuration you want to base the new 

configuration on. 

2. From the Configuration menu select Save As. 

You are prompted for the Supervisor‟s Password to save 

the configuration. 

3. Enter the Supervisor‟s Password and press OK. 

You will be prompted for the name of the new 

configuration. 

4. Enter a unique name for the new configuration. 

Note: You will receive an error message if 

you enter a configuration name that 

already exists. 

5. Press OK. 

The new configuration is saved and opened.  The 

configuration name will appear on the title bar. 
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Setting Up and Defining Indexing 
Configurations 

The PowerFilm Index Control Tab allows the user to enter 

indexing data that may be linked to each image or range of 

images in a batch.  The indexing data may then be exported 

in *.IDX format, for compatibility with the CDPublish and 

CDRetrieve software solutions, or in comma delimited 

*.CSV format. 

Users are also able to open previously scanned batches even 

if a scanner is not attached.  This can be useful if it is a 

requirement to offload the index process to a later time or to 

different operators.  Users are able to view and index the 

images in a previously scanned batch as well as Print, Fax 

and Email individual images or ranges of images. 

See Chapter 5 Control and Operation for information on 

using the Index Control Tab and opening previously scanned 

batches. 

Indexing Setup 

To setup the indexing schemes for each configuration open 

the configuration you want to apply the indexing scheme to 

and select Setup Indexing from the Configurations menu. 

The Indexing Configuration screen is only available under 

Supervisor password control so PowerFilm will now prompt 

you for the Supervisor Password. 

When the Supervisors password is entered the Indexing 

Configuration screen will appear. 
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The Index Configuration Setup screen consists of the 

following components. 

Field Configuration 

This section allows you to control all the properties of the 

highlighted field or the field to be added to the configuration  

A maximum of ten fields can be defined (32 characters per 

field). 

 

Label 

 

The Label Name for the field. 

(maximum 15 characters) 

 

 
 

Fig 11. The Index Configuration Setup Screen 
 



 

PowerFilm User Manual 6-22 

Field Type 

 

The type of data to be entered into 

the field.  If the user enters data 

not in the specified type a warning 

message will be displayed. 

 

Text: - Any alpha numeric 

characters. 

 

Date: - A date format field. 

 

Number: - Any numeric 

characters. 

 

Default Value Type 

 

Defines the type of any default 

value to be applied to this field.  It 

is possible to make the default 

value type a date even if the type 

field is text. 

 

No Default: - No default value 

will be applied. 

 

Text: - The default value type will 

be Alpha numeric. 

 

Short Date: - The default value 

type will be in the Windows short 

date format as defined in control 

panel.  i.e. 09/05/98. 

 

Long Date: - The default value 

type will be in the Windows long 

date format as defined in control 

panel.  i.e. 09 May 1998. 

 

Default Value 

 

Enter the default value for the 

field in the appropriate format. 
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Required 

 

Check this check box if the field 

should be mandatory.  The user 

will not be able to scan or move to 

another image if the field is not 

completed in the correct format. 

 

Read Only 

 

Check this check box if the field 

should be read only.  You should 

enter a default value that will 

always be applied to this field.  

Users will not be able to change 

this value. 

 

Add 

 

When all the properties for the 

field have been defined press Add 

to add the new index field to the 

configuration.  The new index 

field will appear in the list above 

and its properties will be 

displayed from right to left. 

 

Change 

 

Highlight an existing field in the 

field list, make any required 

property changes and then press 

the Change button to apply the 

new properties to that field. 

 

Delete 

 

 

Highlight the field you want to 

delete in the field list and then 

press the Delete button to delete 

the field. 

 

Default Field Select the field you would like to 

automatically get focus after an 

image is scanned or after 

navigating from one page to 

another in the batch. 
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Position Arrows 

The Blue position arrows allow you to move any field up and 

down in the field list altering the order that the fields will be 

displayed in the Index Control Tab. 

Press OK to save the new indexing scheme into the current 

configuration. 

Note: You should test any new indexing schemes to ensure 

that they behave in the way that you had planned before 

giving users access to the new configuration and indexing 

scheme. 
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PowerFilm Log Files 
To assist in the debugging of any problems that may be 

encountered with the PowerFilm software, PowerFilm writes 

out a daily log file to the PowerFilm installation directory. 

The log file contains cryptic data that is intended for support 

representatives rather that operators. 

At the beginning of each day PowerFilm.log is renamed to 

PowerFilm.log.bak and a new PowerFilm.log file is created 

for the current day.  There will therefore be a maximum of 

two days of log information available for debugging 

purposes.  If problems are experienced with the PowerFilm 

software you may be asked to send the log files to your 

support representative for review. 

If an on-going problem is experienced it may be wise to save 

all the daily log files until the problem is resolved. 

Example Log File 
Fri 08 May 1998 22:23:43 : Error 7: Out of memory:  in 
frmMain:DisplayBatchSettings 

Fri 08 May 1998 22:23:44 : Error 7: Out of memory:  in 
frmMain:DisplayBatchSettings 

Fri 08 May 1998 22:23:45 : Error 7: Out of memory:  in 
frmMain:DisplayBatchSettings 

Fri 08 May 1998 22:23:46 : Error 7: Out of memory:  in 
frmMain:DisplayBatchSettings 

Fri 08 May 1998 22:23:47 : Error 7: Out of memory:  in 
frmMain:DisplayBatchSettings 

Fri 08 May 1998 22:23:48 : Error 7: Out of memory:  in 
frmMain:DisplayBatchSettings 
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Chapter 7 E-Mail, Print, 
Fax Integration 

Overview 
This Chapter discusses the Print, Fax and Email capabilities 

of PowerFilm. 

Once a batch of images has been scanned, and before the 

batch is closed, the user has the option of Printing, Faxing or 

Emailing the currently displayed image or ranges of images. 

It is also possible to Print, Fax or Email images when a 

previously scanned batch is loaded back into PowerFilm, via 

the Load Batch command on the File menu.  See Chapter 5 

Control and Operation for information on loading previously 

scanned batches into PowerFilm. 

Printing Images 
This section discusses manually printing images scanned into 

a batch.  See Chapter 5 – Control and Operation (Option 

Tab) for information on Scan to Printer mode. 
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PowerFilm prints images via the standard Windows printer 

drivers. 

1. Scan an image or a range of images. 

2. Select Print from the File menu or press the 

Print button on the button bar. 

 

Hint: Print is also available by pressing the F2 function 

key. 

The Print dialog box appears. 

 

 

 

 

 

 

 

 
 

3. Select the printer you wish to print to. 

Note: PowerFilm will remember the printer you choose 

and default to it the next time you print an image. 

 
 

Fig 1. The Print Dialog Box 
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Print Options 

Lists formats you can specify for a printed page or document. 

 

Fit to page Fits the page contents to the page 

size that you specified in your 

printer properties. 

 

Inch to Inch Prints the page contents at the 

same size as the physical scanned 

or faxed page. Output that extends 

beyond the paper size is cropped. 

 

Pixel to pixel Prints one pixel of output for each 

pixel of input. For example, if the 

input resolution is 200 dots per 

inch (dpi), and the output 

resolution is 100 dpi, the output 

will be two times as wide and two 

times as long as the input. Printing 

that extends beyond the page size 

is cropped. 

Printing 

Print the current image, all the images scanned in the batch or 

a range of images. 

You can select to print multiple copies by typing the number 

of copies in the “Copies” box. 

If you have defined an area on an image with the mouse, you 

can print the selected area by enabling the „Selected Area‟ 

check box.  This check box is only available when an area 

has been defined with the mouse. 
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Faxing Images 
PowerFilm allows you to fax images to any fax management 

software that integrates with Windows via the use of a Fax 

Printer Driver. 

1. Scan an image or a range of images. 

2. Select Fax from the File menu or press the Fax 

button on the button bar. 

 

Hint: Fax is also available by pressing the F3 function key. 

The Fax dialog box appears. 

3. Select the Fax Printer Driver you wish to print to. 

 
 

Fig 2. The Fax Dialog Box 



 

Chapter 7 E-Mail, Print, Fax Integration  7-5 7-5 

Note: PowerFilm will remember the fax printer driver you 

choose and default to it next time you fax an image.  You will 

not be shown the alternative printer drivers.  Should you want 

to select an alternative fax printer driver at any time in the 

future you will need to choose Clear Setting from the Fax 

Settings in the PowerFilm Options setup.  See Chapter 6 

System Administration for details on how to do this. 

Fax Print Options 

Lists formats you can specify when the image is submitted to 

the fax printer driver. 

 

Fit to page Fits the page contents to the page 

size that you specified in your 

printer properties. 

 

Inch to Inch Prints the page contents at the 

same size as the physical scanned 

or faxed page. Output that extends 

beyond the paper size is cropped. 

 

Pixel to pixel Prints one pixel of output for each 

pixel of input. For example, if the 

input resolution is 200 dots per 

inch (dpi), and the output 

resolution is 100 dpi, the output 

will be two times as wide and two 

times as long as the input. Printing 

that extends beyond the page size 

is cropped. 

Sending the Fax 

Print the current image, all the images scanned in the batch or 

a range of images to the Fax Printer Driver. 

You can select to print multiple copies by typing the number 

of copies in the “Copies” box. 
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If you have defined an area on an image with the mouse, you 

can fax the selected area by enabling the „Selected Area‟ 

check box.  This check box is only available when an area 

has been defined with the mouse. 
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Emailing Images 
PowerFilm integrates with your MAPI (Mail Application 

Programming Interface) client and allows you to send the 

current image in the image viewing window, a range of 

images or all the images in a batch as Email attachments. 

If you send more than one image to your default MAPI client, 

PowerFilm will group all the images together in one mult-

page TIFF file. 

1. Scan an image or a range of images. 

2. Select Email from the File menu or press the 

Email button on the button bar. 

 

Hint: Email is also available by pressing the F4 function key. 

The Email dialog box appears. 

 
 

Fig 3. The Send Email Dialog Box 
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Sending the Email 

Send the current image, all the images scanned in the batch or 

a range of images to your default MAPI client. 

Note: Your default MAPI client will open and your 

image(s) will be displayed as an attachment in a New 

Message.  Choose your recipients and press Send to send the 

message. 

Hint: As Windows Messaging also supports Fax Routing 

it is also possible to send Faxes this way. 

Please refer to your Windows ® operating system user 

manual for details of how to define your default MAPI client. 

Emailing Selected Image Areas 

If you have defined an area on an image with the mouse, you 

can email the selected area by enabling the „Selected Area‟ 

check box.  This check box is only available when an area 

has been defined with the mouse. 

Emailing Images as PDF Files 

If you would like the page range of images you have selected 

to be attached to your out going email as a single PDF file, 

you can choose to select the „Attach as PDF‟ check box. 

 
 

Fig 4. Attach as PDF 
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Chapter 8 Localisation 

Overview 
This section deals with the processes and files involved in 

translating all of the PowerFilm menus, dialogs, pick lists and 

messages into alternative languages. 

Menus, Dialogs and Messages 
The PowerFilm menus, dialogs and messages are, by default, 

all displayed in English.  However, it is possible to configure 

PowerFilm to load the string values for each of the menus, 

dialogs and messages from a text file as the program is 

started.  

PowerFilm Options Screen 

The Setup Tab on the PowerFilm Options screen allows you 

to define if Localisation is required and which Localisation 

initialisation file should be used. 
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To Access the PowerFilm Options Screen select Options 

from the File menu.  Select the Settings Tab. 

The Localisation section of the Settings Tab consists of the 

following options. 

 

 
 

Fig 1. The PowerFilm Options Screen 
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Localisation Required If this check box is enabled 

PowerFilm will attempt to load all 

menus, dialogs, pick lists and 

messages from the specified 

Localisation INI file. 

 

Local INI File Double click here and navigate to 

the required Localisation INI file. 

 

The Localisation Initialisation (ini) 
File 

The localisation INI file is a simple text file formatted in the 

Windows INI file format. 

The Localisation file is divided into twenty sections with 

each section heading in square brackets. 

 

MAIN 

 

Control Tab names and properties. 

 

MENU 

 

All menu options. 

TOOLBAR 

 

Button bar tool tips (hover help) 

COMBODATA 

 

The contents of the pick lists on 

the Control Tabs. 

 

BATCH 

 

The contents of the Accept Batch 

dialog box. 

 

CONFIG 

 

The contents of the Configuration 

Name dialog box. 

 

OPTIONS 

 

The contents of the contents of the 

Tabs on the PowerFilm Options 

screen. 
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DELETE 

 

The contents of the Delete 

Configuration dialog. 

 

EMAIL 

 

The contents of the Send Email 

Dialog box. 

 

EXIT 

 

The contents of the Exit 

PowerScan dialog box. 

 

INDEX 

 

The contents of the Index 

Configuration screen. 

INDEX_COMBO 

 

The contents of the pick lists on 

the Index Configuration screen. 

 

OPENCONFIG 

 

The contents of the Open 

Configuration dialog box. 

 

PASSWORD 

 

The contents of the Enter 

Supervisor Password dialog box. 

 

SERIAL 

 

The contents of the initial Enter 

Serial Number dialog box that 

appears when PowerFilm is 

started for the first time. 

 

VIEWOP 

 

The contents of the View Options 

dialog box. 

 

MESSAGE 

 

General PowerFilm messages. 

 

ERRORS 

 

General PowerFilm error 

messages. 

 

REGISTRY ERRORS 

 

Errors when writing to the 

Windows registry. 

 

GENERAL Other General messages. 

 

STATUS_BAR 

 

Status Bar messages. 
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Note: If no entry is found in the localisation file, 

PowerFilm will load the English default value. 

 

Note: It is not possible to translate the Shortcut keys, e.g. 

F2 - Print).  Shortcut keys will always remain at the English 

defaults.  Menu Accelerators may be customised by 

preceding the accelerator character with an Ampersand (&), 

e.g. &My File Menu. 

 

Note: To enter other language text into the localisation file 

you should be running the appropriate language version of 

Windows. 

 

Note: Always make sure that the custom language text is 

no longer than the English defaults otherwise they may not fit 

in the dialog or screen space.  The maximum character length 

for any field is 128 characters. 

Example Localisation ini File 
 

[MAIN] 
[MAIN] 
Set Size=Set Size1 
Fix Size=Fix Size1 
Film=Film1 
Setup Film=Setup Film1 
MARS Control=MARS Control1 
Setup=Setup1 
Goto Start=Goto Start1 
Rewind=Rewind1 
Blip Configuration=Blip Configuration1 
Polarity=Polarity1 
Level=level1 
Opaque=Opaque1 
Single=Single1 
Transparent=Transparent1 
Dual=Dual1 
Search=Search1 
Batch=Batch1 
Frame=Frame1 
Move=Move1 
Distance=Distance1 
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Microfilm=Microfilm1 
ScanAll=ScanAll1 
ScanNext=ScanNext1 
Frames=Frames1 
Current Position=Current Position1 
Batches=Batches1 
Edge Detection=Edge Detection1 
Scan=Scan1 
Forwards=Forwards1 
Backwards=Backwards1 
Negative=Negative1 
Positive=Positive1 
Start Of Film=Start Of Film1 
MRS 60 Control=MRS 60 Control1 
Tiff Type=TIFF TYPE1 
Max Pages=Max Pages1 
Scan to Printer=Scan to Printer1 
BlankPageThreshold=BlankPageThreshold1 
Format=Format1 
Renumber=Renumber1 
Type=Type1 
Auto Eliminate Frame=Auto Eliminate Frame1 
Film Mode=Film Mode1 
Film Type=Film Type1 
Count Mode=Count Mode1 
Scanning Mode=Scanning Mode1 
Scan to Batch=Scan to Batch1 
Scan to Printer=Scan to Printer1 
Browse=Browse1 
Microfilm Scan Control=Microfilm Scan Control1 
Threshold=Threshold1 
Border Erasure=Border Erasure1 
Index=Index1 
New Index=New Index1 
Base Directory=Base Dir1 
Image File Naming=Image File Naming1 
Batch Subdirs=Batch Subdirs1 
Files per Subdir=Files per Subdir1 
Name Prefix=Name Prefix1 
Tif Start=Tif Start1 
Restart Count=Restart Count1 
Continuous Count = Continuous Count1 
Output=Output1 
Comma Delimited=Comma Delimited1 
Batch Balance=Batch Balance1 
Estimated=Estimated1 
Scanned=Scanned1 
Item=Item1 
Image=Image1 
Image Mode=Image Mode1 
Configuration=Configuration1 
Image Size=Image Size1 
Left=Left1 
Top=Top1 
Width=Width1 
Height=Height1 
mm=mm1 
Rotation=Rotation1 
Image Attributes=Image Attributes1 
Resolution=Resolution1 
Composition=Composition1 
Compression=Compression1 
Save As=Save As1 
Brightness=Brightness1 
Brightness (Manual)=Brightness (Manual)1 
Brightness (Auto Exposure)=Brightness (Auto Exposure)1 
White=White1 
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Black=Black1 
Contrast=Contrast1 
Low=Low1 
High=High1 
Options=Options1 
Photo Interpret=Photo Interpret1 
Positive=Positive1 
Negative=Negative1 
Auto=Auto1 
Reverse=Reverse1 
Auto Mask=Auto Mask1 
Finger Detect=Finger Detect1 
Centering=Centering1 
Book Comp=Book Comp1 
Key Scanning=Key Scanning1 
Deskew=Deskew1 
Auto Focus=Auto Focus1 
Auto Exposure=Auto Exposure1 
Height of Original=Height of Original1 
Sheet=Sheet1 
Centre-line Erasure=Centre-line Erasure1 
Automatic=Automatic1 
Fixed=Fixed1 
None=None1 
ForceOverwrite=Force Overwrite1 
 
[MENU] 
File=File1 
FilePrint=Fileprint1 
FileFax=FileFax1 
FileEmail=FileEmail1 
FileNewConfig=FileNewConfig1 
FileOpenConfig=FileOpenConfig1 
FileSave=FileSave1 
FileSaveAs=FileSaveAs1 
FileRename=FileRename1 
FileDelete=FileDelete1 
FileExit=FileExit1 
FileLoadBatch=FileLoadBatch1 
Config=Config1 
SetupIndex=SetupIndex1 
Action=Action1 
ActionRew=ActionRew1 
ActionScan=ActionScan1 
ActionSaveBatch=ActionSaveBatch1 
ActionMoveNext=ActionMoveNext1 
ActionCancelScan=ActionCancelScan1 
FileGotoStart=FileGotoStart1 
ActionGotoStart=GotoStart1 
View=View1 
ViewKeepSelected=ViewKeepSelected1 
ViewOptions=ViewOptions1 
ViewNext=ViewNext1 
ViewPrevious=ViewPrevious1 
ViewFirst=ViewFirst1 
ViewLast=ViewLast1 
ViewRotateLeft=ViewRotateLeft1 
ViewRotateRight=ViewRotateRight1 
ViewDelete=ViewDelete1 
ViewSave=ViewSave1 
ViewScaleToGray=ViewScaleToGray1 
ViewFitTo0=Fit To Page 1 
ViewFitTo1=Fit To Width 1 
ViewFitTo2=Fit To Height 1 
ViewCut=Cut1 
ViewCopy=Copy1 
ViewPaste=Paste1 
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Options=Options1 
OptionsConfirmation=OptionsConfirmation1 
Help=Help1 
HelpMenu=HelpMenu1 
HelpAbout=HelpAbout1 
FileLoadSuspendedBatch=Load Suspended Batch1 
FileSaveImageAs0=File Save Image As1 
FileSaveImageAs1=File Save MultiPage Image As1 
ViewShowViewers1=Show 1 Viewer1 
ViewShowViewers4=Show 4 Viewers1 
ViewShowViewers6=Show 6 Viewers1 
FileCDPublish=CD Publish1 
 
[TOOLBAR] 
Start Scanning=start tooltip 
Resume scanning=Resume scanning tooltip 
Close Batch=Close Batch tooltip 
Cancel Scanning=Cancel tooltip 
Print=print tooltip 
Fax=fax tooltip 
Mail=Mail tooltip 
Rewind=Rewind tooltip 
Save Configuration=save config tooltip 
Move to Next Frame=Move to next tooltip 
Select=Select tooltip 
Drag=Drag tooltip 
Zoom Value=Zoom Value tooltip 
Zoom In= Zoom In tooltip 
Zoom Out = Zoom Out tooltip 
Zoom To Select=Zoom To Select tooltip 
Rotate Left= Rotate Left tooltip 
Rotate Right=Rotate Right tooltip 
Previous Page=Previous Page tooltip 
Next Page=Next Page tooltip 
Cut / Mask White=Cut/Mask tooltip 
Copy=Copy tooltip 
Paste=Paste tooltip 
Delete Image=Delete Image tooltip 
Save Image=Save Image tooltip 
Previous Doc=Previous Doc tooltip 
Next Doc=Next Doc tooltip 
Rescan Image=Rescan tooltip 
 
[COMBODATA] 
Centre Scan Mode=C Scan1 
Left Scan Mode=L Scan1 
Right Scan Mode=R Scan1 
Full Screen Mode=Full Screen1 
Cheque Film (Single)=Single1 
Cheque Film (Dual)=Dual1 
Duplex=Duplex1 
Spread Scan=Spread Scan1 
Left Page=L Page1 
Right Page=R Page1 
Fine Mode 1=Fine1 
Fine Mode 2=Fine2 
Text=Text1 
Picture=Picture1 
None=None1 
CCITT G3-1D=G3-1D 1 
CCITT G3-Huffman=Huffman1 
CCITT G4-2D=CCITT G4 1 
Count=count1 
Start/Stop=start/stop1 
Black and White=b and w1 
Custom=custom1 
No Rotation=No Rotation1 



 

Chapter 8 Localisation  8-9 8-9 

90° Left=90° Left1 
180°=180°1 
90° Right=90° Right1 
CD Publish=CD Publish1 
Comma Delimited=Comma Delimited1 
Kofax Ascent=Kofax Ascent1 
PDF and Tif=PDF and Tif1 
PDF Only=PDF Only1 
Greyscale=Greyscale1 
Custom=Custom1 
Custom Front=Custom Front1 
Custom Back=Custom Back1 
Duplex Custom=Duplex Custom1 
Duplex (Merge)=Duplex (Merge)1 
Duplex Custom (Merge)=Duplex Custom (Merge)1 
Split Scan Left / Right=Split Scan Left / Right1 
Split Scan Right / Left=Split Scan Right / Left1 
Single Document=Single Document1 
MPage Doc Per Batch=MPage Doc Per Batch1 
MPage Doc Boundary=MPage Doc Boundary1 
 
[BATCH] 
Batch=Batch1 
Continue=Continue1 
Accept=Accept1 
Reject=Reject1 
Do You Want To Continue=Do you want to continue with the current batch, suspend the 
batch, accept this batch or reject the batch?1 
Suspend=Suspend1 
 
[CONFIG] 
Configuration Name=Configuration Name1 
Name=Name1 
OK=OK1 
Cancel=Cancel1 
From File=From File1 
BatchInProgress=Batch In Progress1 
 
[OPTIONS] 
Options=Options1 
Confirmation=Confirmation1 
Controller=Controller1 
Password=Password1 
Settings=Settings1 
Confirm On=Confirm On1 
Program Exit=Program Exit1 
Config Delete=Config Delete1 
Image Delete=Image Delete1 
Accept Batch=Accept Batch1 
Reject Batch=Reject Batch1 
Save Image=Save Image1 
MARS Options=MARS Options1 
Search for MARS=Search for MARS1 
Count0=Count01 
Count1=Count11 
Com Port=Com Port1 
Com1=Com11 
Com2=Com21 
Com3=Com31 
Com4=Com41 
Baud Rate=Baud Rate1 
Parity=Parity1 
None=None1 
Odd=Odd1 
Even=Even1 
Stop Length=Stop Length1 
1Bit=1Bit1 
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2Bit=2Bit1 
Character Length=Character Length1 
8Bit=8Bit1 
7Bit=7Bit1 
OK=OK1 
Cancel=Cancel1 
Please Enter Supervisor=Please Enter Supervisor1 
Please Enter New Supervisor=Please Enter New Supervisor1 
Confirm Supervisor=Confirm Supervisor1 
Localisation=Localisation1 
Localisation Required=Localisation Required1 
Fax Settings=Fax Settings1 
Enable Fax=Enable Fax1 
Clear Setting=Clear Setting1 
Configuration=Configuration1 
Prompt to Save=Prompt to Save1 
Enable Edge Detection=Enable Edge Detection1 
Edge Detection=Edge Detection1 
PDF=PDF1 
Max Tiffs=Max Tiffs1 
Seconds=Seconds1 
Creation=Creation1 
LocalINIFile=Local INI File1 
 
[DELETE] 
Delete Configuration=Delete Configuration1 
This Will Delete Current Config=This Will Delete Current Config1 
OK=OK1 
Cancel=Cancel1 
 
[EMAIL] 
Send Email=Send Email1 
Print=Print1 
Fax=Fax1 
Pixel to pixel=Pixel to pixel1 
Inch to inch=Inch to inch1 
Fit to page=Fit to page1 
All=All1 
Print Options=Print Options1 
Selected=Selected1 
From=From1 
To=To1 
Current=Current1 
OK=OK1 
Cancel=Cancel1 
Copies=Copies1 
SelectedArea=SelectedArea1 
 
[EXIT] 
Exit=Exit1 
This Will End Session=This Will End Session1 
OK=OK1 
Cancel=Cancel1 
 
[INDEX] 
Indexing Configuration=Indexing Configuration1 
Field Configuration=Field Configuration1 
Label=Label1 
Field Type=Field Type1 
Default Value=Default Value1 
Default Type=Default Type1 
Add=Add1 
Change=Change1 
Delete=Delete1 
Required=Required1 
ReadOnly=ReadOnly1 
OK=OK1 
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Cancel=Cancel1 
Default Field Configuration=Default Field Configuration1 
Default Field=Default Field1 
[INDEX_COMBO] 
NoDefault=NoDefault1 
Text=Text1 
ShortDate=ShortDate1 
LongDate=LongDate1 
FieldText=FieldText1 
FieldDate=FieldDate1 
FieldNumber=FieldNumber1 
 
 
[OPENCONFIG] 
Open Configuration=Open Configuration1 
Configuration=Configuration1 
OK=OK1 
Cancel=Cancel1 
 
[PASSWORD] 
Enter Password=Enter Password1 
Password=Password1 
OK=OK1 
Cancel=Cancel1 
 
[SERIAL] 
Serial Number=Serial Number1 
Please Enter Serial=Please Enter Serial1 
Please Enter Supervisor=Please Enter Supervisor1 
Confirm Supervisor=Confirm Supervisor1 
OK=OK1 
 
[VIEWOP] 
Viewing Options=Viewing Options1 
Show Every=Show Every1 
Image=Image1 
Show By=Show By1 
Frame=Frame1 
Batch=Batch1 
OK=OK1 
Cancel=Cancel1 
 
[MESSAGE] 
Already Running=is already running1. 
Cannot Quit=Cannot quit whilst minimised1. 
Login Save Config=Enter supervisor password to save Configuration1 
Login SaveAs Config=Enter supervisor password to allow current configuration to be saved 
as a new configuration1 
Login New Config=Enter supervisor password to create new Configuration1 
Login Rename Config=Enter supervisor password to Rename Configuration1 
Login Delete Config=Enter supervisor password to Delete Configuration1 
Login Index=Enter supervisor password to Setup Index Fields1 
Save File=Enter supervisor password to save the image1 
M1=Please enter a serial number1. 
M2=The passwords must both be the same1. 
M3=Please enter a password1. 
M4=End of film reached1. 
M5=Cannot rewind the film whilst a batch is in progress1. 
M6=Cannot quit whilst there is an unfinished batch1. 
M7=Cannot change configuration whilst a batch is in progress1. 
M8=Cannot load a batch whilst a batch is in progress1. 
M9=Do you really want to delete this page1? 
M10=Do you really want to accept this batch?  NOTE You will not be able to scan more 
images into this batch once it is accepted1. 
M11=Do you really want to reject this batch1? 
M12=There are no pages to save. Do you want to delete the batch1? 
M13=Please enter a value for field1 
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M14=Do you want to save the changes to the image1? 
M15=Changes to will not be effective until1 
M16=is restarted1. 
M17=You have not entered the correct password1. 
M18=A configuration of that name already exists.  Please enter a new name1. 
M19=Any changes made will not be saved.  Do you want to continue without saving1? 
M20=A default value must be given if the field is read only1. 
M21=A default value of date cannot be applied to a number field type1. 
M22=A number must be given as the default value if one is required1. 
M23=A date must be given as the default value if one is required1. 
M24=System Information Is Unavailable At This Time1 
M25=Invalid Password, try again1! 
M26=Please enter a number1. 
M27=There are no printers defined1. 
M28=The following error has occurred1: 
M29=End of film reached, scanning stopped1. 
M30=The film is loaded.  Cannot change the mode1. 
M31=A maximum of 10 index fields are allowed1. 
M32=Please enter a license key for the MRS controller1. 
M33=The license key entered is invalid1. 
M34=Rescan is not available in this scan mode1. 
M35=This paper size is not supported at 600DPI1.  
M36=You must not be in Scan to Printer mode to close the batch. 
M37=Front and back image sizes are not compatible.  Please re-configure image sizes1. 
M38=An in progress batch has been detected. Do you want to recover it1? 
M39=An unsuccessful attempt has been made to recover batch  
M40=Choose Yes to suspend the batch or No to delete it. 
M41=The log file is not the correct format and cannot be loaded1. 
M42=You can only open suspended batches on the PC they where suspended on. 
M43=You can only restore batches on the PC they where scanned on. 
M44=Do you want to try to suspend the batch? 
M45=The maximum resolution for this paper size is 
M46=The output path for PDF files cannot contain a space. 
M47=Kofax registry settings not found.  Ensure that Kofax Ascent is correctly installed. 
M48=The required Kofax program has not been found.  Ensure that Kofax Ascent is correctly 
installed. 
 
[ERRORS] 
E1=Please check the scanner is attached and switched on1. 
E2=Please check the Book Scanner is attached and switched on1. 
E3=A date must be entered for field1 
E4=A number must be entered for field1 
E5=Please put the Book Scanner into PC mode1. 
E6=Cannot find Tiff 2 PDF Converter1. 
E7=An error occurred whilst producing the pdf  
E8=An error occurred whilst running the Kofax import. 
 
[REGISTRY ERRORS] 
ER1=Error creating key1 
ER2=Error opening key1 
ER3=Error closing key1 
ER4=Error deleting key1 
ER5=Error enumerating sub-keys1 
ER5=Error enumerating values1 
ER7=Error getting registry value1 
ER8=Error writing registry value1 
ER9=Error deleting registry value1 
 
[GENERAL] 
using=Using1 
SuspendedBatches=SuspendedBatches1 
 
[STATUS_BAR] 
Scanning=Scanning...1 
Waiting=Waiting for Key press to start scan...1 
Final Wait=Waiting for final 20 second timeout...1 
Delete=Deleting current batch1. 
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Saving=Saving batch index and configuration files1. 
Cancel requested=Cancel requested1 
Multipage=Creating multipage tif1. 
Printing=Printing1... 
Faxing=Faxing1... 
Sending Message=Sending Message1... 
Printing Image=Printing Image1 
Browsed Image=Browsed Image1 
Printed Image=Printed Image1 
Scan Area Too Big=Defined Scan Area is too large for selected Resolution or Composition1 
Cancellation=Scanning Completed due to Cancel Request1 
Document=Document1 
Page=Page1 
of=of1 
PDF=Processing through PDF converter1. 
Kofax=Uploading batch to Kofax Ascent1.
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Chapter 9 CDPublish 

What is CDPublish? 
CDPublish is a Windows based software solution that builds 

a database from batches of images stored in a standard 

Windows Folder structure. 

Each folder contains; scanned TIFF images, a file containing 

the associated index data and a configuration file that details 

index field labels and other information supplied by the 

Image Capture System that created the batch.  The process of 

building this database is referred to as Publishing.  CDPublish 

is launched from the PowerFilm File Menu. 

CDPublish Published Database and 
Batch Folder Structure 

CDPublish builds a Published Database in the folder directly 

above the folders containing batches of images. 

 

 

 

 
 

Fig 1. Published Database and Batch Folder File Structure 
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Batches of Images 

Images grouped together in a Folder are called Batches.  A 

Batch is simply a logical collection of images.  For example, 

a Batch may contain all the images that relate to a particular 

subject, department or company.  Alternatively, each Batch 

could represent a document or a folder of documents.  The 

Batch would have been created as the images were scanned.   

 

 

 

 

 

 

 

 

 

 

 

The Batch Folder also contains two other files; DocFolder.cfg 

and DocFolder.idx, that contain index data relating to the 

images.  The PowerFilm, and PowerBook Image Capture 

Systems, also developed by InfoCAP Technologies, 

automatically create these files as batches of images are 

scanned.  If an alternative Image Capture System is used to 

create the batches of images it must also create DocFolder.cfg 

and DocFolder.idx files that conform to the file specifications 

detailed in Chapter 12 – CDPublish Technical Reference, of 

this manual. 

 

Fig 2. A Batch of Images and Associated Index Files 
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Retrieving the Batches and Images 
with CDRetrieve 

Once the Database has been Published, CDPublish‟s sister 

product CDRetrieve may be used to facilitate the retrieval of 

images, or groups of images stored in the batches, based upon 

index data that has been applied to the images. 

CDRetrieve is an integral part of CDPublish and is launched 

from the CDPublish main window button bar.  Use 

CDRetrieve to test Published Databases prior to distribution. 

Copying the Files onto CD 
The File and Folder structure shown in Fig 1. Above may be 

copied onto Recordable or Re-Writable CD so that the 

Published Database may be distributed to other users. 

Note: CDPublish does not include software to copy files 

onto CD.  This software is usually distributed with 

the Recordable or Re-Writable CD drives and 

includes software such as Adaptec‟s Direct CD. 

The Operating System 
A Microsoft Windows-based application, CDPublish operates 

on PC platforms running Windows 2000 Professional, 

Windows XP Professional, Windows Vista Business and 

Windows 7 Professional.  CDPublish is powerful but 

relatively easy to use; however, operators should know the 

basic Windows controls before running the application. 
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Chapter 10 CDPublish 
User Interface 

The Main Window 
The following sections describe each portion of the 

CDPublish main window. 

 

 

 

 

 

 

 

 

 

 

  
 

Fig 1. The CDPublish User Interface Main Window 
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Title Bar 

The title bar contains the standard MS Windows control 

items including the Windows control menu and 

maximise/minimise buttons.  The centre of the bar displays 

the software‟s title, CDPublish. 

Status Bar 

The left hand side of the status bar displays status information 

during the Publishing process. 

The Centre section displays an image count of the images in 

each batch processed. 

The right hand side of the status bar displays a Publishing 

process indicator as a percentage. 

Published Database Name 

This field allows you to enter the name for the Published 

Database, maximum 255 characters. 

Current Published Database Path 

This is the currently selected folder in which CDPublish will 

create the named Published Database.  The Published 

Database will contain references to batches in sub folders 

directly (and only directly) under this location. 

Use the Drive selector and folder navigator tools to locate the 

desired Folder. 

Menu Bar 

The menu bar contains two menus; File and Help.  The 

following sections list the options available from each menu.   

Some of the menu functions are also available from the main 

window button bar, discussed later in this chapter. 
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To Select an Option from the Menu Bar: 

1. 1.   Using the mouse, click on the menu title (for 

example, File.) 

2. The drop-down menu displays the available 

menu items. 

3. 2.   Click on the desired menu item. 

File Menu 

The following items are available in the File Menu. 

 

Create Published 

Database 

Begin building the desired 

Published Database name in the 

currently selected path. See later 

in this Chapter for more details. 

 

CDRetrieve Opens the CDRetrieve main 

window.  See later in this Chapter 

for more details. 

 

Options Opens the CDPublish Options 

Dialog 

 

Exit Closes CDPublish. 

Help Menu 

There are two items available in the Help menu. 

 

Contents (F1) Displays the CDPublish Online 

User Manual help contents. 

 

About Displays CDPublish copyright and 

version information. 
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Main Window Button Bar 

For easy access, some of the menu functions are also 

available from the main window button bar.  As the mouse is 

hovered over each button, windows hover help is displayed 

indicating the button‟s function. 

 

 Create Published Database. 

Begin building the desired 

Published Database name in the 

currently selected path. See 

Chapter 11 CDPublish Operation 

for more details. 

 

 

 Display Options.  Opens the 

CDPublish Options dialog.  These 

settings are for CDRetrieve display 

options (which may also be set 

from CDRetrieve) and for 

configuring localisation (language 

translation).  See Chapter 13 

CDPublish Localisation for more 

details. 

 

 CDRetrieve.  Launches the 

CDRetrieve main window.  See 

Chapter 11 CDPublish Operation 

for more details  
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Chapter 11 CDPublish 
Operation 

Creating a Published Database 
Following the initial installation, CDPublish defaults to its 

application directory\folder for the Published Database Path, 

e.g. C:\Program Files\KODAK\PowerFilm. 

The default Published Database Name is „Publish‟. 

Selecting the Path for the Published 
Database 

Use the Drive selector and folder navigation controls to 

navigate to the folder that contains the batch folders. 

 

 

 

 

 

 

Fig 1. Published Database and Batch Folder File Structure 
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In the above example, a Published Database called „Company 

Information‟ has been built above three batch folders; 

Bh000001, Bh000002 and Bh000004. 

Note: CDPublish will build the Published Database with 

references to images in batch folders only directly 

under the Published Database path. 

Note: CDPublish always remembers the path of the last 

Published Database that was built and will default to 

it the next time CDPublish is started.  This can be 

useful if you always intend to create Published 

Databases in the same area. 

Selecting the File Name for the 
Published Database 

Enter a valid Windows file name, up to 255 characters. 

Caution: Do not use a „.‟ Character in the name as 

CDPublish will remove all characters following 

the „.‟ from the file name. 

Starting the Publishing Process 

Select Create Published Database from the File menu or 

press the Create Published Database button on the button 

bar.   
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If the Published Database Already Exists 

If a Published Database with the same name already exists in 

the selected path you may choose to OVERWRITE, 

APPEND or CANCEL. 

 

 

 

 

 

 

 

Overwrite the Database 

Select Overwrite if you wish to replace the existing database. 

Any batches you had already published to this database will 

be overwritten by the batches to be published in this session. 

The status bar will display the successful publish 

Append to the Database 

Select Append if you wish to add to the existing database. 

This will add any new batches to the batches already 

published. The process checks to see if any new document 

folders have been created in the published database path since 

the last successful publish. 

The following message will appear if the program detects that 

no new document folders have been selected to publish to the 

database.  

 

 

 

 

 

 
 

Fig 2. Database Already Exists Dialog 
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If the above message does not appear, the status bar will 

display the successful publish. 

Note: You will receive this message if no sub folders exist 

under the selected path or if the sub folders are batch folders 

and contain images but do not contain the required 

DocFolder.cfg and DocFolder.idx files in the correct format.  

See Chapter 12 CDPublish Technical Reference for details of 

these file formats. 

Cancel and Rename Database 

Select Cancel to return to the CDPublish main window and 

rename your database. 

Press OK and rename your database to continue publishing. 

Publishing in Progress 

When the Publishing Process is in progress the CDPublish 

status bar will indicate the current batch name and path being 

processed, a count of the images in each batch and indicator 

of the percentage processed so far. 

When the Publishing process is complete, the status bar will 

indicate that the database was successfully published.  I.e. 

“Company Information.mdb Successfully Published” 

 
 

Fig 3. The No New documents Found Dialog 
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Stopping the Publishing Process 

As the Publishing process begins, the Create Published 

Database button on the button bar will change to a Stop sign.   

 

 

Press the Stop button at any time during the Publishing 

process to pause the Publishing of the database. 

The following message will appear: 

 

 

 

 

 

 

Selecting No resumes the Publishing Process.  If you select 

Yes the following message appears: 

 

 

 

 

 

 

Caution: If you choose not to delete the file, the Published 

Database may contain incomplete records and 

therefore may return incomplete search results. 

 

 
 

Fig 4. Pausing the Publishing Process 

 
 

Fig. 5 Deleting a Paused Published Database 
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Opening CDRetrieve from CDPublish 
Once you have created a Published Database it is wise to 

check the content of the database and perform test searches. 

CDRetrieve is an integral part of CDPublish and can be 

launched from the CDRetrieve button on the CDPublish 

button bar.   

 

Once launched, CDRetrieve behaves in exactly the same way 

as the native product.   

Note: When CDRetrieve is closed, window focus will 

return to the CDPublish main window. 

 

Note: Closing CDPublish while CDRetrieve is still open 

will automatically close CDRetrieve. 

 



 

Chapter 12 CDPublish Technical Reference 12-1 12-1 

Chapter 12 CDPublish 
Technical Reference 

 

Overview 
This Chapter discusses the file formats that are necessary for 

the DocFolder.cfg and DocFolder.idx files that must exist in 

each batch folder in order for CDPublish to correctly process 

the batch. 

Note: The PowerFilm and PowerBook software 

applications automatically create these files. 

DocFolder.cfg 

DocFolder should be replaced with the name of the folder in 

which the batch resides.  For example, if the batch is in a 

folder called Bh000001 then the cfg file should be named 

Bh000001.cfg. 



 

PowerFilm User Manual 12-2 

The content of the file should be formatted as follows: 
 
[CONFIG] 
Description=InfoCAP 
Number Index Fields=5 
[INDEX1] 
Label=Company 
[INDEX2] 
Label=Account No 
[INDEX3] 
Label=Dept Number 
[INDEX4] 
Label=Delivery Note 
[INDEX5] 
Label=Date  

Description 

The Description field is the name of the configuration that 

the Document Capture System used to create the batch.  If 

necessary all batches in the Published Database can use the 

same Description.  Once a description has been used, none of 

the following entries may change for subsequent batches. 

Number of Index Fields 

The number of fields in this configuration. 

Index Field Labels 

These are the label names of all the index fields stored in the 

DocFolder.idx file.  These labels will be used by CDRetrieve 

to search for the batches and images. 

DocFolder.idx 

DocFolder should be replaced with the name of the folder in 

which the batch resides.  For example, if the batch is in a 

folder called Bh000001 then the idx file should be named 

Bh000001.idx. 

The DocFolder.idx file is a fixed field length delimited data 

file.  The index information relating to each image in the 
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batch is represented as a row in the file.  The start positions 

and the field lengths are detailed below. 
 

Start Length Description 

221 32 Index Field 1 

253 32 Index Field 2 

285 32 Index Field 3 

317 32 Index Field 4 

349 32 Index Field 5 

381 32 Index Field 6 

413 32 Index Field 7 

445 32 Index Field 8 

477 32 Index Field 9 

509 32 Index Field 10 

665 33 Filename 

698 2 Carriage Return/Line Feed 

If index values are not the maximum length of 32 characters 

they must be padded to 32 characters. 

Filenames are in the format, Bh000001.tif and the field must 

be padded to 33 characters. 
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Chapter 13 CDPublish 
Localisation 

Overview 
This section deals with the processes and files involved in 

translating all of the CDPublish menus, dialogs and messages 

into alternative languages. 

Menus, Dialogs and Messages 
The CDPublish menus, dialogs and messages are, by default, 

all displayed in English.  However, it is possible to configure 

CDPublish to load the string values for each of the menus, 

dialogs and messages from a text file as the program is 

started.  

CDPublish Options Screen 

The CDPublish Options screen allows you to define if 

Localisation is required and which Localisation initialisation 

file should be used. 
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Select Options from the File menu or press the Display 

Options button on the button bar.   

 

The CDPublish Options dialog appears: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Retrieve Options section is for use with CDRetrieve.  See 

the CDRetrieve documentation for details. 

 

Localisation Required If this check box is enabled 

CDPublish will attempt to load all 

menus, dialogs, pick lists and 

messages from the specified 

Localisation INI file. 

 

Local INI File Double click here and navigate to 

the required Localisation INI file. 

 

 

 

 
 

Fig 1. The CDPublish Options Dialog 
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The Localisation Initialisation (ini) 
File 

The localisation INI file is a simple text file formatted in the 

Windows INI file format. 

The Localisation file is divided into a number of sections 

with each section heading in square brackets. 

For example, the section [PUBLISH_MENU] covers all the 

menus on the CDPublish menu bar. 

 

Note: If no entry is found in the localisation file, 

CDPublish will load the English default value. 

 

Note: It is not possible to translate the Shortcut keys, e.g. 

F2 - Print).  Shortcut keys will always remain at the 

English defaults.  Menu Accelerators may be 

customised by preceding the accelerator character 

with an Ampersand (&), e.g. &My File Menu. 

 

Note: To enter other language text into the localisation file 

you should be running the appropriate language 

version of Windows. 

 

Note: Always make sure that the custom language text is 

no longer than the English defaults otherwise they 

may not fit in the dialog or screen space.  The 

maximum character length for any field is 128 

characters. 
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Example Localisation ini File 

A sample Local.ini file is provided as part of the CDPublish 

installation and is located in the application directory. 

 
[DISPLAY_MENU] 
File=File1 
FilePrint=Fileprint1 
FileFax=FileFax1 
FileEmail=FileEmail1 
FileExit=FileExit1 
FileLoadBatch=FileLoadBatch1 
 
View=View1 
ViewKeepSelected=ViewKeepSelected1 
ViewOptions=ViewOptions1 
ViewNext=ViewNext1 
ViewPrevious=ViewPrevious1 
ViewFirst=ViewFirst1 
ViewLast=ViewLast1 
ViewRotateLeft=ViewRotateLeft1 
ViewRotateRight=ViewRotateRight1 
ViewDelete=ViewDelete1 
ViewSave=ViewSave1 
ViewSaveAs=ViewSaveAs1 
ViewScaleToGray=ViewScaleToGray1 
 
ViewFitTo0=Fit To Page 1 
ViewFitTo1=Fit To Width 1 
ViewFitTo2=Fit To Height 1 
 
ViewCut=Cut1 
ViewCopy=Copy1 
ViewPaste=Paste1 
 
Options=Options1 
OptionsConfirmation=OptionsConfirmation1 
Help=Help1 
HelpContents=HelpMenuContents1 
HelpAbout=HelpAbout1 
 
[DISPLAY_TOOLBAR] 
Print=Print1 
Fax=Fax1 
Mail=Mail1 
Return to CDRetrieve=Return to CDRetrieve1 
 
Select=Select1 
Drag=Drag1 
Zoom Value=Zoom Value1 
Zoom In= Zoom In1 
Zoom Out = Zoom Out1 
Zoom To Select=Zoom To Select1 
Rotate Left= Rotate Left1 
Rotate Right=Rotate Right1 
Previous Page=Previous Page1 
Next Page=Next Page1 
Cut / Mask White=Cut/Mask1 
Copy=Copy1 
Paste=Paste1 
Save Image=Save Image 1 
 
 
[RETRIEVE_FORM] 
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Configurations Found=Configurations found1 
 
[RETRIEVE_MENU] 
File=File1 
FileOptions=Options 1 
FileOpen=Open Published Database1 
FileSearch0=Seacrh Batch1 
FileSearch1=Search Image1 
FileClear=Clear Fields1 
FileView=View Selected Image1 
FileExit=Exit1 
 
Help=Help1 
HelpContents=HelpMenuContents1 
HelpAbout=HelpAbout1 
 
[RETRIEVE_TOOLBAR] 
Open Published Databases=Open Published Databases1 
Display Options=Display Options1 
Search Batches=Search Batches1 
Search Images=Search Images1 
Clear Index Values=Clear Index Values1 
View Document=View Document1 
 
[PUBLISH_FORM] 
Publish Database Name=Publish Database Name1 
Path Frame=Select Path for Published Database1 
Current Path=Current Published Database Path1: 
 
[PUBLISH_MENU] 
File=File1 
FilePublish=Create Published Database1 
FileRetrieve=CDRetrieve1 
FileOptions=Options 1 
FileExit=Exit1 
 
Help=Help1 
HelpContents=HelpMenuContents1 
HelpAbout=HelpAbout1 
 
[PUBLISH_TOOLBAR] 
Create Published Database=Create Published Database1 
Stop=Stop1 
Display Options=Display Options1 
CDRetrieve=CDRetrieve1 
 
 
[EMAIL_FORM] 
Send Email=Send Email1 
Print=Print1 
Fax=Fax1 
Pixel to pixel=Pixel to pixel1 
Inch to inch=Inch to inch1 
Fit to page=Fit to page1 
All=All1 
Print Options=Print Options1 
Selected=Selected1 
From=From1 
To=To1 
Current=Current1 
OK=OK1 
Cancel=Cancel1 
Copies=Copies1 
 
[OPTIONS_FORM] 
Localisation=Localisation1 
Localisation Required=Localisation Required1 
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Retrieve Options=Retrieve Options1 
Max Search Hits=Max Search Hits1 
Max Batch Windows=Max Batch Windows1 
OK=OK1 
Cancel=Cancel1 
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Chapter 14 CDRetrieve 

What is CDRetrieve? 
CDRetrieve is a Windows based software solution that 

facilitates the retrieval of images, or groups of images stored 

in batches, based upon index data that has been applied to the 

images. 

CDRetrieve searches a published database (usually stored on 

a CD along with associated images) that has been created by 

a sister software product called CDPublish.  CDPublish is 

integrated in the PowerFilm and PowerBook software and 

may be launched from the PowerFilm or PowerBook File 

Menu.  Users of PowerFilm/PowerBook are free to distribute 

CDRetrieve, to users that wish to view the published 

databases free of charge.  The installation program for 

CDRetrieve can be found on the PowerFilm and PowerBook 

setup CDs. 

CDPublish creates published databases from index data 

created by InfoCAP Technologies‟ PowerFilm and 

PowerBook image capture software.  It is also compatible 

with other capture solutions, such as Kofax Ascent Capture, 

or with data from any other indexing system that can conform 

to the specification detailed in the CDPublish 

documentation.. 
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Search and Retrieve 
Users are able to search and retrieve images based upon 

information stored in up to 10 index fields.  The index 

information may be Textual, Alphanumeric, Numeric, or in 

Date format.  Wild Card searching is available and a standard 

Boolean „AND‟ function is supported across index fields. 

The original index field labels are displayed to the user for 

search criteria to be entered.  

Image Control 
Once an image has been located, it may be viewed in the 

CDRetrieve Doc View Window (image viewer). 

Users are able to; enlarge/reduce the size of the viewed 

image, rotate the image, navigate through images in a batch 

and perform cut and paste functions. 

Print, Mail and Fax 
Users are able to print individual images, or ranges of images, 

via standard Windows drivers. 

CDRetrieve also provides the facility to e-mail individual 

images, or ranges of images, via Microsoft Messaging 

Services. 

Although Microsoft Messaging Services will allow the user 

to e-mail and fax images, CDRetrieve also provides the 

facility to fax images using other third party fax software that 

integrates via the use of a Fax Print Driver. 

The Operating System 
A Microsoft Windows-based application, CDRetrieve 

operates on PC platforms running Windows 2000 

Professional, Windows XP Professional, Windows Vista 
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Business and Windows 7 Professional.  CDRetrieve is 

powerful but relatively easy to use; however, operators 

should know the basic Windows controls before running the 

application. 
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Chapter 15 CDRetrieve 
User Interface 

The Main Window 
The following sections describe each portion of the 

CDRetrieve main window. 

 

 

 

 

 

 

 

 

 

 

 
 

 

Fig 1. The CDRetrieve User Interface Main Window 
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Title Bar 

The title bar contains the standard MS Windows control 

items including the Windows control menu and 

maximise/minimise buttons.  The centre of the bar displays 

the software‟s title and the path and name of the opened 

Published Database 

Status Bar 

The left hand side of the status bar displays the name of the 

database  

The right hand side of the status bar displays status 

information, e.g., Searching and Found x, where x is the 

number of matches found. 

Configurations Found 

A drop down list of all the profiles associated with this 

particular database is displayed in the left part of the main 

window; index field labels and search fields for the 

configurations found in the published database are shown. 

A configuration is a group of settings that was used to create 

the batch in PowerFilm, PowerBook, or other software 

capable of create batches that conform to the 

CDPublish/CDRetrieve specification. 

Search Results Window 

The right portion of the main window displays the search 

results in a grid format, one row for each hit.  Each column in 

the grid will reflect the index data stored in the published 

database. 

Menu Bar 

The menu bar contains two menus; File and Help.  The 

following sections list the options available from each menu.   
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Some of the menu functions are also available from the main 

window button bar, discussed later in this chapter. 

To Select an Option from the Menu Bar: 

1.   Using the mouse, click on the menu title (for 

example, File.) 

The drop-down menu displays the available menu 

items. 

2.   Click on the desired menu item. 

File Menu 

The following items are available in the File Menu. 

 

Options Opens the Options Dialog to allow 

you to configure Maximum 

Search Hits displayed and 

Maximum Doc View Windows 

(image viewer windows) that may 

be opened.  See Chapter 16 

CDRetrieve Operation for more 

details. 

 

Open Published 

Database 

Allows you to open an existing 

Published Database from your CD 

drive or from your hard disk. See 

Chapter 16 CDRetrieve Operation 

for more details. 

 

Search Batch Allows you to search the 

Published Database based upon 

specified index search criteria and 

display batches that match. See 

Chapter 16 CDRetrieve Operation 

for more details. 

 



 

PowerFilm User Manual 15-4 

Search Allows you to search the 

Published database based upon 

specified index search criteria and 

display images that match in any 

batch in the Published Database 

 

If no index fields are selected the 

search will return all documents 

associated with the selected 

Configuration Profile. See Chapter 

16 CDRetrieve Operation for 

more details. 

 

Clear Fields Clears any index search criteria 

that may be entered on the search 

form. 

 

View Selected Image 

 

Opens the selected image (or 

batch) into the CDRetrieve Doc 

View Window (image viewer) 

 

Exit Closes CDRetrieve. 

Help Menu 

There are two items available in the Help menu. 

 

Contents (F1) Displays the CDRetrieve User 

Manual electronic help contents. 

 

About Displays CDRetrieve copyright and 

version information. 

Main Window Button Bar 

For easy access, many of the menu functions are also 

available from the main window button bar.  As the mouse is 

hovered over each button, windows hover help is displayed 

indicating the buttons function. 
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 Open Published Database. Allows 

you to open an existing Published 

Database from your CD drive or 

from your hard disk. See Chapter 

16 CDRetrieve Operation for more 

details. 

 

 

 Display Options.  Opens the 

Options Dialog to allow you to 

configure Maximum Search Hits 

displayed and Maximum Doc View 

Windows (image viewer windows) 

that may be opened.  See Chapter 

16 CDRetrieve Operation for more 

details  

 

 Search Batch.  Allows you to 

search the Published Database 

based upon specified index search 

criteria and display batches that 

match. See Chapter 16 CDRetrieve 

Operation for more details. 

 

Note: This button only appears 

once a Published Database has 

been opened. 
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Search Image.  Allows you to 

search the Published database 

based upon specified index search 

criteria and display images that 

match in any batch in the Published 

Database. See Chapter 16 

CDRetrieve Operation for more 

details. 

 

Note: This button only appears 

once a Published Database has 

been opened. 

 

 Clear Index Values.  Clears any 

index search criteria that may be 

entered on the search form. 

 

Note: This button only appears 

once a Published Database has 

been opened. 

 

 View Document.  Opens the 

selected image (or batch) into the 

CDRetrieve Doc View Window 

(image viewer) 

 

Note: This button only appears 

once a Published Database has 

been opened. 

 

CDRetrieve Doc View Window (Image 
Viewer) 

After entering search criteria and instigating a search, the 

search results are displayed in the Search Results Grid 

located in the right portion of the main window. 
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Highlighting any one of the hits (rows) in the Search Results 

Grid and pressing the View Document button opens the 

CDRetrieve Doc View Window (image viewer). 

 

The selected image or batch is loaded in to the CDRetrieve 

Doc View Window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Title Bar 

The title bar contains the standard MS Windows control 

items including the Windows control menu and 

maximise/minimise buttons.  The centre of the bar displays 

the path and name of the original configuration used to create 

the displayed batch. 

 
 

Fig 2. The CDRetrieve Doc View Window 
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Status Bar 

The right hand side of the status bar displays the path and the 

name of the current image being displayed. 

Index Fields 

The left portion of the CDRetrieve Doc View Window 

displays the original index information applied to image(s) in 

read only mode. 

Menu Bar 

The menu bar contains three menus;  File, View and Help.  

The following sections list the options available from each 

menu.  Where appropriate, accelerator keys are shown in 

brackets for each menu function. 

Many of the menu functions are also available from the Doc 

View Window button bar, discussed later in this chapter. 

To Select an Option from the Menu Bar: 

1.   Using the mouse, click on the menu title (for 

example, File. 

The drop-down menu displays the available menu 

items. 

2.   Click on the desired menu item. 

File Menu 

The following items are available in the CDRetrieve Doc 

View Window File Menu. 
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Print (F2) Allows you to print individual 

images or a range of images.  See 

Chapter 17 CDRetrieve Mail, 

Print and Fax Integration for 

more details. 

 

Fax (F3) Allows you to fax individual 

images or a range of images to 

third party fax software that may 

be installed on your PC.  See 

Chapter 17 CDRetrieve Mail, 

Print and Fax Integration for 

more details. 

 

Email (F4) Allows you to Email individual 

images or a range of images.  See 

Chapter 17 CDRetrieve Mail, 

Print and Fax Integration for 

more details. 

 

Exit Closes the CDRetrieve Doc View 

Window. 

View Menu 

The following items are available in the CDRetrieve Doc 

View Window View Menu. 

 

Next (F12) Displays the next image in the 

batch. 

 

Previous (F11) Displays the previous image in the 

batch. 

 

First (F9) Displays the first image in the 

batch. 

 

Last (Ctrl+E) Displays the last image in the 

batch. 
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Hide Property Fields 

(F6) 

Hides the Property Fields (Index 

Fields) so that a greater area is 

available to view the images. 

 

Rotate Left (Ctrl+L) Rotates the current image 90° to the 

left. 

 

Rotate Right (Ctrl+R) Rotates the current image 90° to the 

right. 

 

Save (Ctrl+S) Saves any rotations or changes to 

the current image to a temp file to 

allow you to Print, Fax or E-mail 

the image. 

 

Save As 

 

Allows you to save the currently 

displayed image to an alternative 

folder and filename. 

 

Scale to Gray Sets the image viewer display 

mode to Scale to Gray.  Grayscale 

display makes black and white 

documents easier to read, and is 

most effective at a zoom 

percentage of less than 100%. 

 

Fit to Page (Ctrl+P) Fits the current image to the size of 

the viewing window and saves this 

view for subsequent images. 

 

Fit to Width (Ctrl+W) Fits the current image to the width 

of the viewing window and saves 

this view for subsequent images. 

 

Fit to Height (Ctrl+H) Fits the current image to the height 

of the viewing window and saves 

this view for subsequent images. 
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Cut (Ctrl+X) Cuts a selected area of the image to 

the Windows clipboard.  This 

function is also used to Redact 

(Mask White) unwanted or 

sensitive areas of the image before 

the image is printed, faxed or e-

mailed. 

 

Copy (Ctrl+C) Copies a selected area of the image 

to the Windows clipboard. 

 

Keep Selected (Ctrl+K) Reduces the current image to the 

size of the selected area.  This is 

not a viewing function; the actual 

image size is reduced. 

 

Paste (Ctrl+V) If the Cut or Copy functions have 

previously been used, this function 

pastes the contents of the Windows 

clipboard into the image viewing 

window 

Help Menu 

There is one item available in the CDRetrieve Doc View 

Window Help menu. 

 

About Displays CDRetrieve copyright and 

version. 

Doc View Window Button Bar 

For easy access, many of the menu functions are also 

available from the Doc View Window button bar.  As the 

mouse is hovered over each button, windows hover help is 

displayed indicating the buttons function. 
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Print.  Print the current image or 

range of images. 

 

 
Fax.  Fax the current image or 

range of images 

 

 
Mail.  Email the current image or 

range of images. 

 

 
Return to CDRetrieve.  Closes the 

current Doc View Window and 

returns to the CDRetrieve main 

window. 

 

 
Select.  Sets the image viewer 

window to Zoom mode.  In this 

mode you can rubber band an area 

of the image viewer window you 

wish to enlarge. 

 

 
Drag.  Sets the image viewer 

window to Drag mode.  Only 

functional if the current image does 

not fit in the image viewer window.  

In this mode you can drag the 

image in any direction to view 

different areas of the image. 

 

 

 
Allows you to set a custom view 

size. 

 

 
Zoom in.  Zooms in on the image 

in the image viewer window. 

 

 
Zoom out.  Zooms out on the 

image in the image viewer window. 
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Zoom to Select.  Zooms to the area 

of the image selected by rubber 

banding with the mouse while in 

Select mode. 

 

 
Rotate Left.  Rotates the image 

90° to the left. 

 

 
Rotate Right.  Rotates the image 

90° to the Right. 

 

 
Page Navigation.  Left arrow 

moves to previous page.  Right 

Arrow moves to next page.  

Entering a value in the box and 

pressing enter moves to a specific 

image in the batch. 

 

 
Cut / Mask White.  Cuts a selected 

area of the image to the Windows 

clipboard.  This function is also 

used to Redact (Mask White) 

unwanted or sensitive areas of the 

image before the image is printed, 

faxed or e-mailed. 

 

 
Copy.  Copies a selected area of 

the image to the Windows 

clipboard. 

 

 
Paste.  If the Cut or Copy functions 

have previously been used, this 

function pastes the contents of the 

Windows clipboard into the image 

viewing window 
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Save Image.  Saves any rotations 

or changes to the current image to a 

temp file to allow you to Print, Fax 

or E-mail the image. 
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Chapter 16 CDRetrieve 
Operation 

Published Databases 
CDRetrieve allows you open Published Databases created by 

CDPublish.  

CDPublish Published Database and 
Batch Folder Structure 

CDPublish builds a Published Database in the folder directly 

above the folders containing batches of images. 

 

 

 

 

Fig 1. Published Database and Batch Folder File Structure 
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Batches of Images 

Images grouped together in a Folder are called Batches.  A 

Batch is simply a logical collection of images.  For example, 

a Batch may contain all the images that relate to a particular 

subject, department or company.  Alternatively, each Batch 

could represent a document or a folder of documents.  The 

Batch would have been created as the images were scanned.   

 

 

 

 

 

 

 

 

 

 

 

 

The Batch Folder also contains two other files; 

DocFolder.cfg and DocFolder.idx that contain index data 

relating to the images.  These files are for CDRetrieve 

internal use only. 

Opening a Published Database 

Press the Open Published Database button: 

 

Or select Open Published Database from the File menu. 

The CDRetrieve Open Published Database dialog box 

appears: 

 
Fig 2. A Batch of Images and Associated Index Files 
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Navigate to the location of your published database.  If this is 

on your CD drive then select the drive letter for the CD drive 

from the Look In pick list.  Highlight the name of the 

Published database and press OK. 

Note: CDRetrieve will remember the last location that you 

opened a Published Database from.  So if this is 

always your CD drive, selecting Open Published 

Database will always display the Published 

Databases in the root of the currently loaded CD. 

 
 

Fig 3. The Open Published Database Dialog 
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Searching for Batches or Images 
Once a Published Database has been opened, the Search 

Batches, Search Images, Clear Index Values and View 

Document buttons will become available. 

 

 

 

The Configurations Found pick list will display the names of 

all the original configurations used to create the batches of 

images in the Published Database. 

Note: Although it is possible that the published database 

may contain batches of images created by many different 

configurations, it is more likely that the Database would have 

been published with batches of images all created with the 

same configuration. 

Default Index Configuration 

CDRetrieve will always display a configuration called 

Default Index.  This configuration uses default field labels 

and displays all 10 index search fields.  The Default Index 

configuration is used to search for batches or images that may 

have been created with any configuration. 
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Starting a Search 

Select the configuration you wish to use to search for batches 

or images. 

The index search field labels will be updated to reflect the 

index field labels that were originally used to index the 

images. 

 

 

 

 

 

 

 

 

 

 

 

Enter your search criteria in any of the index search fields. 

Press Search Batches or Search Images. 

Tip If your cursor is positioned in any of the index 

search fields, pressing CARRIAGE RETURN or ENTER 

will instigate Search Images. 

 

 

Search Batches 
 

 
 

Fig 4. Index Search Fields Updated as Configuration is Opened 
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Use Search Batches when you want to find all batches in the 

Published Database that contain images that match your 

specified search criteria.  This is useful if one or more of the 

index values used to index the batch was batch related, for 

example - a batch ID number. 

Search Images  

 

 

Use Search Images when you want to find all images in the 

Published Database that match your specified search criteria. 

If no index values have been selected, search will return 

every document in that database. 

Note: To abort a search, press the ESC key on your 

keyboard. 

Using Wild Cards 

CDRetrieve supports standard Wild Card characters as part of 

the search criteria, i.e. “?” and “*”. 

Examples: 

1. To search for all images where the value of an 

index field begins with the prefix DN, type DN* 

and start the search. 

2.  To search for all images where the value of an 

index field may have the same last five characters 

but the first character may vary, type ?12345 and 

start the search. 

3.  The “?” character may be used multiple times 

to replace variable characters in the search string.  

I.e. ?1234? would search for a six character string 

where the middle four characters are 2345 
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irrespective of the values of the first and last 

characters. 

4.  The “?” and “*” characters may be mixed in a 

string, i.e., ?12* would search for any string where 

the second and third characters were 12, the first 

character could vary and the end characters may 

contain any values. 

Narrowing the Search 

CDRetrieve allows you to perform a Boolean “AND” 

operation across index search fields. 

In this example, searching for all images where the Company 

Name field value is ACME LTD returns 15 hits. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Fig 5. Searching with one Index Value 
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Specifying that the Department Number is G86986 reduces 

the number of hits to 6. 

 

 

 

 

 

 

 

 

 

 

 

CDRetrieve has searched for all images where the Company 

name is “ACME LTD” AND the Dept Number is “G86986” 

Index Value Lookups 

CDRetrieve allows you to preview the index values stored in 

the Published Database, for each index search field, prior to 

starting a search. 

Pressing the down arrow on any index search field will show 

a list of all the stored values for that field. 

Hint: If you wish to narrow the number of entries in the 

list, you can type the initial characters of the string 

you are interested in, followed by the “*” wildcard 

character, and then press the down arrow.  This 

feature also works with the “?” wildcard character. 

 

 

 
 

Fig 6. Narrowing the Search 
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Note: Once a value has been entered into an index search 

field, pressing the down arrow will only show index 

values that match the current data.  If you wish to 

select a different value from the lookup list you need 

to first clear the current value and then press the 

down arrow. 

  Clear the current value either by pressing the Clear 

Index Values button or by selecting a null value 

from the look up pick list. 

The Search Results Grid 

The Search Results Grid displays the batches or the images 

that match the search criteria that you specified. 

 

 

 

 

 

 
 

Fig 7. Index Value Lookups 
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The first four columns provide the following information: 

 

Hit No The number of the hit in the current 

search results list. 

 

Original Configuration The name of the original 

configuration used to create the 

batch when it was scanned. 

 

Batch Path The path to the batch displayed 

referenced from the location of the 

Published Database. 

 

Image No The image number in the batch that 

the hit was found on.  If you have a 

batch made of several single page 

TIFF images this number 

represents the page number. 

 

Note: multiple images in the same 

batch may be displayed if they all 

contain the specified index data. 

 
 

Fig 8. The Search Results Grid 
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Subsequent columns in the Search Results Grid then display 

the index data applied to each image or batch.  The column 

headings reflect the label name of the index field. 

Hint: Increase the size of the window or use the scroll bars 

to view more columns. 

Sorting Columns 

CDRetrieve allows you to sort the data in any of the columns 

in ascending or descending order.  To sort a column, select 

the column heading with a left mouse click.  Click again to 

switch between ascending and descending. 

Max Search Hits Option 

CDRetrieve allows you to specify the maximum amount of 

hits that you would like to be displayed in the Search Results 

Grid.  The maximum value is 20,000. 

This can be useful if the search criteria you have specified is 

clearly going to display far too many hits in the Search 

Results Grid for you to browse through. 

Select Options from the File menu or press the Display 

Options button on the button bar.   

 

The CDRetrieve Options dialog appears: 
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Note: The Localisation section is to enable language 

translation of the CDRetrieve menus and messages 

and is discussed in Chapter 7 Localisation. 

Note: The Max Doc View Windows setting is discussed 

later in this chapter under Displaying Batches and 

Images. 

The default maximum number of Search Hits is 20.  Enter the 

desired setting for your requirements and press OK.  A 

setting of 0 disables this feature. 

If the maximum number of Search hits is encountered during 

a search, CDRetrieve will warn you with the following 

message: 

 

 

 

 

 
 

Fig 9. The CDRetrieve Options Window 

 
 

Fig. 10. Maximum Rows Found Message 
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Refine your query to reduce the number of hits displayed. 
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Displaying Batches and Images 
Once you have found the batches or images you are looking 

for, you can display them in CDRetrieve‟s Doc View 

Window. 

Highlight the batch or image in the Search Results Grid.  To 

open the batch or image into the Doc View Window either; 

double click the batch or image, or, press the View 

Document button on the button bar.   

 

The batch or image is opened into the CDRetrieve Doc View 

Window. 

 

 

 

 

 

 

 

 

 

 

 

 

Note: When opening an image the entire batch that the 

image resides in is opened in the Doc View Window.  

However, CDRetrieve positions the current image display on 

the image that was found in the hit list. This allows you to 

view images scanned before or after the selected image. 

 

 
 

Fig 11. The CDRetrieve Doc View Window 
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Displaying Multiple Doc View 
Windows 

CDRetrieve allows you to open multiple numbers of Doc 

View Windows at the same time.  This allows you to 

compare images from different batches side by side or even 

compare different images in the same batch side by side. 

To open additional Doc View Windows simply double click 

the row on the Search Results Grid or select the row and 

press the View Document button on the CDRetrieve main 

button bar.  

 

Note: Closing the CDRetrieve main window will 

automatically close all Doc View Windows that may 

be open. 

Returning to the CDRetrieve Main Window 

When multiple Doc View Windows are open it can 

sometimes be difficult to navigate back to the CDRetrieve 

main window.  The Return to CDRetrieve button on the 

Doc View Window tool bar closes the current Doc View 

Window and returns focus to the CDRetrieve main window. 

 

Note: This button has no effect on any other currently 

opened Doc View Windows. 

Max Doc View Windows Option 

CDRetrieve allows you to specify the maximum number of 

Doc View Windows that may be opened at any one time.  

This allows you to prevent your Windows Desktop from 

becoming too cluttered with Doc View Windows. 

Select Options from the CDRetrieve main window File menu 

or press the Options button on the button bar.   
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The CDRetrieve Options dialog appears: 

 

 

 

 

 

 

 

 

 

 

 

Note: The Localisation section is to enable language 

translation of the CDRetrieve menus and messages 

and is discussed in Chapter 18 CDRetrieve 

Localisation. 

Note: The Max Search Hits setting is discussed earlier in 

this chapter under Searching for Batches or Images. 

The Default setting is 5. Enter the desired setting for your 

requirements and press OK.  A setting of 0 disables this 

feature.   

When the maximum number of Doc View Windows has been 

reached, the following message will be displayed when you 

attempt to open another Doc View Window: 

 

 

 
 

Fig 12. The CDRetrieve Options Window 

 
 

Fig 13.  Max No of Doc View Windows Reached 
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Chapter 17 CDRetrieve 
Mail, Print, Fax 
Integration 

 

Overview 
This Chapter discusses the Print, Fax and Email capabilities 

of CDRetrieve. 

Once a batch of images has been opened in the Doc View 

Window the user has the option of Printing, Faxing or E-

mailing the currently displayed image or ranges of images. 

Image Manipulation 

CDRetrieve provides access to Cut, Paste, Keep Selected and 

image rotation functionality to allow you to Print, Fax or E-

mail appropriate images.  As the images are likely to be read 
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only - stored on a CD, any changes made to the image are 

saved to a temporary image file before the modified image 

may be Printed, Faxed or E-mailed. 

After making any changes to the image, select Save from the 

View menu or press Save Image on the Doc View Window 

button bar. 

 

Note: Any number of images in a batch may be modified 

and saved to temporary files.  All the temporary files 

will be deleted when the Doc View Window is 

closed. 

Printing Images 
CDRetrieve prints images via the standard Windows printer 

drivers. 

1. Open a batch or an image into the Doc View 

Window. 

2. Select Print from the File menu or press the 

Print button on the button bar. 

 

Hint: Print is also available by pressing the F2 function 

key. 

The Print dialog box appears. 
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3. Select the printer you wish to print to. 

Note: CDRetrieve will remember the printer you choose 

and default to it next time you print an image. 

Print Options 

Lists formats you can specify for a printed page or document. 

 

Fit to page Fits the page contents to the page 

size that you specified in your 

printer properties. 

 

Inch to Inch Prints the page contents at the 

same size as the physical scanned 

or faxed page. Output that extends 

beyond the paper size is cropped. 

 

 
 

Fig 1. The Print Dialog Box 
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Pixel to pixel Prints one pixel of output for each 

pixel of input. For example, if the 

input resolution is 200 dots per 

inch (dpi), and the output 

resolution is 100 dpi, the output 

will be two times as wide and two 

times as long as the input. Printing 

that extends beyond the page size 

is cropped. 

Printing 

Print the current image, all the images scanned in the batch or 

a range of images.  Select the number of copies required. 

Faxing Images 
CDRetrieve allows you to fax images to any fax management 

software that integrates with Windows via the use of a Fax 

Printer Driver. 

1. Open a batch or an image into the Doc View 

Window. 

2. Select Fax from the File menu or press the Fax 

button on the button bar. 

 

Hint: Fax is also available by pressing the F3 function 

key. 

The Fax dialog box appears. 
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3. Select the Fax Printer Driver you wish to print to. 

Note: CDRetrieve will remember the fax printer driver you 

choose and default to it next time you fax an image.   

Fax Print Options 

Lists formats you can specify when the image is submitted to 

the fax printer driver. 

 

Fit to page Fits the page contents to the page 

size that you specified in your 

printer properties. 

 

Inch to Inch Prints the page contents at the 

same size as the physical scanned 

or faxed page. Output that extends 

beyond the paper size is cropped. 

 

 
 

Fig 2. The Fax Dialog Box 
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Pixel to pixel Prints one pixel of output for each 

pixel of input. For example, if the 

input resolution is 200 dots per 

inch (dpi), and the output 

resolution is 100 dpi, the output 

will be two times as wide and two 

times as long as the input. Printing 

that extends beyond the page size 

is cropped. 

Sending the Fax 

Fax the current image, all the images scanned in the batch or 

a range of images to the Fax Printer Driver. 

Emailing Images 
CDRetrieve integrates with Window Messaging Services and 

allows you to send the current image in the image viewing 

window, a range of images or all the images in a batch as 

Email attachments. 

If you send more than one image to the Windows Messaging 

Service, CDRetrieve will group all the images together in one 

multi-page TIFF file. 

1. Open a batch or an image into the Doc View 

Window. 

2. Select Email from the File menu or press the 

Email button on the button bar. 

 

Hint: Email is also available by pressing the F4 function 

key. 

The Email dialog box appears. 
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Sending the Email 

Send the current image, all the images scanned in the batch or 

a range of images to the Windows Messaging Service. 

Note: Windows Messaging will open and your image(s) 

will be displayed as an attachment in a New 

Message.  Choose your recipients and press Send to 

send the message. 

 

Hint: As Windows Messaging also supports Fax Routing 

it is also possible to send Faxes this way. 

 

 
 

Fig 3. The Send Email Dialog Box 
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Chapter 18 CDRetrieve 
Localisation 

Overview 
This section deals with the processes and files involved in 

translating all of the CDRetrieve menus, dialogs and 

messages into alternative languages. 

Menus, Dialogs and Messages 
The CDRetrieve menus, dialogs and messages are, by default, 

all displayed in English.  However, it is possible to configure 

CDRetrieve to load the string values for each of the menus, 

dialogs and messages from a text file as the program is 

started.  

CDRetrieve Options Screen 

The CDRetrieve Options screen allows you to define if 

Localisation is required and which Localisation initialisation 

file should be used. 
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Select Options from the File menu or press the Display 

Options button on the button bar.   

 

The CDRetrieve Options dialog appears: 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Retrieve Options section is discussed in Chapter 5 

Operation. 

 

Localisation Required If this check box is enabled 

CDRetrieve will attempt to load 

all menus, dialogs, pick lists and 

messages from the specified 

Localisation INI file. 

 

Local INI File Double click here and navigate to 

the required Localisation INI file. 

 

 

 

 
 

Fig 1. The CDRetrieve Options Dialog 
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The Localisation Initialisation (ini) 
File 

The localisation INI file is a simple text file formatted in the 

Windows INI file format. 

The Localisation file is divided into a number of sections 

with each section heading in square brackets. 

For example, the section [RETRIEVE_MENU] covers all the 

menus on the CDRetrieve menu bar. 

Note: If no entry is found in the localisation file, 

CDRetrieve will load the English default value. 

 

Note: It is not possible to translate the Shortcut keys, e.g. 

F2 - Print).  Shortcut keys will always remain at the 

English defaults.  Menu Accelerators may be 

customised by preceding the accelerator character 

with an Ampersand (&), e.g. &My File Menu. 

 

Note: To enter other language text into the localisation file 

you should be running the appropriate language 

version of Windows. 

 

Note: Always make sure that the custom language text is 

no longer than the English defaults otherwise they 

may not fit in the dialog or screen space.  The 

maximum character length for any field is 128 

characters. 

Example Localisation ini File 

A sample Local.ini file is provided as part of the CDRetrieve 

installation and is located in the application directory. 
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[DISPLAY_MENU] 
File=File1 
FilePrint=Fileprint1 
FileFax=FileFax1 
FileEmail=FileEmail1 
FileExit=FileExit1 
FileLoadBatch=FileLoadBatch1 
 
View=View1 
ViewKeepSelected=ViewKeepSelected1 
ViewOptions=ViewOptions1 
ViewNext=ViewNext1 
ViewPrevious=ViewPrevious1 
ViewFirst=ViewFirst1 
ViewLast=ViewLast1 
ViewRotateLeft=ViewRotateLeft1 
ViewRotateRight=ViewRotateRight1 
ViewDelete=ViewDelete1 
ViewSave=ViewSave1 
ViewSaveAs=ViewSaveAs1 
ViewScaleToGray=ViewScaleToGray1 
 
ViewFitTo0=Fit To Page 1 
ViewFitTo1=Fit To Width 1 
ViewFitTo2=Fit To Height 1 
 
ViewCut=Cut1 
ViewCopy=Copy1 
ViewPaste=Paste1 
 
Options=Options1 
OptionsConfirmation=OptionsConfirmation1 
Help=Help1 
HelpContents=HelpMenuContents1 
HelpAbout=HelpAbout1 
 
[DISPLAY_TOOLBAR] 
Print=Print1 
Fax=Fax1 
Mail=Mail1 
Return to CDRetrieve=Return to CDRetrieve1 
 
Select=Select1 
Drag=Drag1 
Zoom Value=Zoom Value1 
Zoom In= Zoom In1 
Zoom Out = Zoom Out1 
Zoom To Select=Zoom To Select1 
Rotate Left= Rotate Left1 
Rotate Right=Rotate Right1 
Previous Page=Previous Page1 
Next Page=Next Page1 
Cut / Mask White=Cut/Mask1 
Copy=Copy1 
Paste=Paste1 
Save Image=Save Image 1 
 
 
[RETRIEVE_FORM] 
Configurations Found=Configurations found1 
 
[RETRIEVE_MENU] 
File=File1 
FileOptions=Options 1 
FileOpen=Open Published Database1 
FileSearch0=Seacrh Batch1 
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FileSearch1=Search Image1 
FileClear=Clear Fields1 
FileView=View Selected Image1 
FileExit=Exit1 
 
Help=Help1 
HelpContents=HelpMenuContents1 
HelpAbout=HelpAbout1 
 
[RETRIEVE_TOOLBAR] 
Open Published Databases=Open Published Databases1 
Display Options=Display Options1 
Search Batches=Search Batches1 
Search Images=Search Images1 
Clear Index Values=Clear Index Values1 
View Document=View Document1 
 
[PUBLISH_FORM] 
Publish Database Name=Publish Database Name1 
Path Frame=Select Path for Published Database1 
Current Path=Current Published Database Path1: 
 
[PUBLISH_MENU] 
File=File1 
FilePublish=Create Published Database1 
FileRetrieve=CDRetrieve1 
FileOptions=Options 1 
FileExit=Exit1 
 
Help=Help1 
HelpContents=HelpMenuContents1 
HelpAbout=HelpAbout1 
 
[PUBLISH_TOOLBAR] 
Create Published Database=Create Published Database1 
Stop=Stop1 
Display Options=Display Options1 
CDRetrieve=CDRetrieve1 
 
 
[EMAIL_FORM] 
Send Email=Send Email1 
Print=Print1 
Fax=Fax1 
Pixel to pixel=Pixel to pixel1 
Inch to inch=Inch to inch1 
Fit to page=Fit to page1 
All=All1 
Print Options=Print Options1 
Selected=Selected1 
From=From1 
To=To1 
Current=Current1 
OK=OK1 
Cancel=Cancel1 
Copies=Copies1 
 
[OPTIONS_FORM] 
Localisation=Localisation1 
Localisation Required=Localisation Required1 
Retrieve Options=Retrieve Options1 
Max Search Hits=Max Search Hits1 
Max Batch Windows=Max Batch Windows1 
OK=OK1 
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